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MODUL 1: 

SEJARAH PERKEMBANGAN 

TEKNOLOGI INFORMASI DAN KOMUNIKASI 
 
 

Mengenal Komputer 

Istilah komputer mempunyai arti yang luas dan berbeda bagi setiap orang. Istilah 

komputer (computer) diambil dari bahasa Latin computare yang berarti menghitung (to 

compute atau to reckon). 
 

Menurut Blissmer (1985), komputer adalah suatu alat elektronik yang mampu 

melakukan beberapa tugas, yaitu menerima input, memproses input sesuai dengan instruksi 

yang diberikan, menyimpan perintah-perintah dan hasil pengolahannya, serta menyediakan 

output dalam bentuk informasi. 
 

Sedangkan menurut Sanders (1985), komputer adalah sistem elektronik untuk 

memanipulasi data yang cepat dan tepat serta dirancang dan diorganisasikan supaya secara 

otomatis menerima dan menyimpan data input, memprosesnya, dan menghasilkan output 

berdasarkan instruksi-instruksi yang telah tersimpan di dalam memori. Dan masih banyak 

lagi ahli yang mencoba mendefinisikan secara berbeda tentang komputer. Namun, pada 

intinya dapat disimpulkan bahwa komputer adalah suatu peralatan elektronik yang dapat 

menerima input, mengolah input, memberikan informasi, menggunakan suatu program yang 

tersimpan di memori komputer, dapat menyimpan program dan hasil pengolahan, serta 

bekerja secara otomatis. 
 

Dari definisi tersebut terdapat tiga istilah penting, yaitu input (data), pengolahan data, 

dan informasi (output). Pengolahan data dengan menggunakan komputer dikenal dengan 

nama pengolahan data elektronik (PDE) atau elecronic data processing (EDP). Data adalah 

kumpulan kejadian yang diangkat dari suatu kenyataan (fakta), dapat berupa angka-angka, 

huruf, simbol-simbol khusus, atau gabungan dari ketiganya. Data masih belum dapat 

bercerita banyak sehingga perlu diolah lebih lanjut. 
 

Pengolahan data merupakan suatu proses manipulasi dari data ke dalam bentuk 

yang lebih berguna dan lebih berati, yaitu berupa suatu informasi. Dengan demikian, 

informasi adalah hasil dari suatu kegiatan pengolahan data yang memberikan bentuk yang 

lebih bermakna dari suatu fakta. Oleh karena itu, pengolahan data elektronik adalah proses 

manipulasi dari data ke dalam bentuk yang lebih bermakna berupa suatu informasi dengan 

menggunakan suatu alat elektronik, yaitu komputer. 
 

Sejak dahulu kala, proses pengolahan data telah dilakukan oleh manusia. Manusia 

juga menemukan alat-alat mekanik dan elektronik untuk membantu manusia dalam 

penghitungan dan pengolahan data supaya bisa mendapatkan hasil lebih cepat. Komputer 

yang kita temui saat ini adalah suatu evolusi panjang dari penemuan-penemuan manusia 

sejah dahulu kala berupa alat mekanik maupun elektronik. 
 

Saat ini komputer dan piranti pendukungnya telah masuk dalam setiap aspek 

kehidupan dan pekerjaan. Komputer yang ada sekarang memiliki kemampuan yang lebih 

dari sekedar perhitungan matematik biasa. Diantaranya adalah sistem komputer di kassa



 

supermarket yang mampu membaca kode barang belanjaan, sentral telepon yang 

menangani jutaan panggilan dan komunikasi, jaringan komputer dan internet yang 

mennghubungkan berbagai tempat di dunia. 
 

Bagaimanapun juga alat pengolah data dari sejak jaman purba sampai saat ini bisa 

kita golongkan ke dalam 4 golongan besar. 
 

1. Peralatan manual: yaitu peralatan pengolahan data yang sangat sederhana, dan faktor 

terpenting dalam pemakaian alat adalah menggunakan tenaga tangan manusia 
 

2. Peralatan Mekanik: yaitu peralatan yang sudah berbentuk mekanik yang digerakkan 

dengan tangan secara manual 
 

3. Peralatan Mekanik Elektronik: Peralatan mekanik yang digerakkan oleh secara otomatis 

oleh motor elektronik 
 

4. Peralatan Elektronik: Peralatan yang bekerjanya secara elektronik penuh 
 

Generasi Komputer 
 

KOMPUTER GENERASI PERTAMA 
 

Dengan terjadinya Perang Dunia Kedua, negara-negara yang terlibat dalam perang 

tersebut berusaha mengembangkan komputer untuk mengeksploit potensi strategis yang 

dimiliki komputer. Hal ini meningkatkan pendanaan pengembangan komputer serta 

mempercepat kemajuan teknik komputer. Pada tahun 1941, Konrad Zuse, seorang insinyur 

Jerman membangun sebuah komputer, Z3, untuk mendesain pesawat terbang dan peluru 

kendali 

 
 
 
 
 
 
 
 
 
 

Pihak sekutu juga membuat kemajuan lain dalam pengembangan kekuatan 

komputer. Tahun 1943, pihak Inggris menyelesaikan komputer pemecah kode rahasia yang 

dinamakan Colossus untuk memecahkan kode-rahasia yang digunakan Jerman. Dampak 

pembuatan Colossus tidak terlalu mempengaruhi perkembangan industri komputer 

dikarenakan dua alasan. Pertama, colossus bukan merupakan komputer serbaguna 

(general-purpose computer), ia hanya didesain untuk memecahkan kode rahasia. Kedua, 

keberadaan mesin ini dijaga kerahasiaannya hingga satu dekade setelah perang berakhir.



 

Usaha yang dilakukan oleh pihak Amerika pada saat itu menghasilkan suatu 

kemajuan lain. Howard H. Aiken (1900-1973), seorang insinyur Harvard yang bekerja 

dengan IBM, berhasil memproduksi kalkulator elektronik untuk US Navy. Kalkulator tersebut 

berukuran panjang setengah lapangan bola kaki dan memiliki rentang kabel sepanjang 500 

mil. The Harvd-IBM Automatic Sequence Controlled Calculator, atau Mark I, merupakan 

komputer relai elektronik. Ia menggunakan sinyal elektromagnetik untuk menggerakkan 

komponen mekanik. Mesin tersebut beropreasi dengan lambat (ia membutuhkan 3-5 detik 

untuk setiap perhitungan) dan tidak fleksibel (urutan kalkulasi tidak dapat diubah). Kalkulator 

tersebut dapat melakukan perhitungan aritmatik dasar dan persamaan yang lebih kompleks. 
 

Perkembangan komputer lain pada masa kini adalah Electronic Numerical Integrator 

and Computer (ENIAC), yang dibuat oleh kerjasama antara pemerintah Amerika Serikat dan 

University of Pennsylvania. Terdiri dari 18.000 tabung vakum, 70.000 resistor, dan 5 juta titik 

solder, computer tersebut merupakan mesin yang sangat besar yang mengkonsumsi daya 

sebesar 160kW. 

 
 
 
 
 
 
 
 
 

Komputer ini dirancang oleh John Presper Eckert (1919-1995) dn John W. Mauchly 

(1907-1980), ENIAC merupakan komputer serbaguna (general purpose computer) yang 

bekerja 1000 kali lebih cepat dibandingkan Mark I. 
 

Pada pertengahan 1940-an, John von Neumann (1903-1957) bergabung dengan tim 

University of Pennsylvania dalam usha membangun konsep desin komputer yang hingga 40 

tahun mendatang masih dipakai dalam teknik komputer. Von Neumann mendesain 

Electronic Discrete Variable Automatic Computer(EDVAC) pada tahun 1945 dengan sebuh 

memori untuk menampung baik program ataupun data. Teknik ini memungkinkan komputer 

untuk berhenti pada suatu saat dan kemudian melanjutkan pekerjaannya kembali. Kunci 

utama arsitektur von Neumann adalah unit pemrosesan sentral (CPU), yang memungkinkan 

seluruh fungsi komputer untuk dikoordinasikan melalui satu sumber tunggal. Tahun 1951, 

UNIVAC I (Universal Automatic Computer I) yang dibuat oleh Remington Rand, menjadi 

komputer komersial pertama yang memanfaatkan model arsitektur von Neumann tersebut. 

 
 
 
 
 
 
 
 
 

Baik Badan Sensus Amerika Serikat dan General Electric memiliki UNIVAC. Salah 

satu hasil mengesankan yang dicapai oleh UNIVAC dalah keberhasilannya dalam 

memprediksi kemenangan Dwilight D. Eisenhower dalam pemilihan presiden tahun 1952.



 

Komputer Generasi pertama dikarakteristik dengan fakta bahwa instruksi operasi 

dibuat secara spesifik untuk suatu tugas tertentu. Setiap komputer memiliki program kode-

biner yang berbeda yang disebut “bahasa mesin” (machine language). Hal ini menyebabkan 

komputer sulit untuk diprogram dan membatasi kecepatannya. 

 
 
 
 
 
 
 
 

Ciri lain komputer generasi pertama adalah penggunaan tube vakum (yang membuat 

komputer pada masa tersebut berukuran sangat besar) dn silinder magnetik untuk 

penyimpanan data. 
 

KOMPUTER GENERASI KEDUA 
 

Pada tahun 1948, penemuan transistor sangat mempengaruhi perkembangan 

komputer. Transistor menggantikan tube vakum di televisi, radio, dan komputer. Akibatnya, 

ukuran mesin-mesin elektrik berkurang drastis. 

 
 
 
 
 
 
 
 
 
 

Transistor mulai digunakan di dalam komputer mulai pada tahun 1956. Penemuan 

lain yang berupa pengembangan memori inti-magnetik membantu pengembangan komputer 

generasi kedua yang lebih kecil, lebih cepat, lebih dapat diandalkan, dan lebih hemat energi 

dibanding para pendahulunya. Mesin pertama yang memanfaatkan teknologi baru ini adalah 

superkomputer. IBM membuat superkomputer bernama Stretch, dan Sprery-Rand membuat 

komputer bernama LARC. Komputerkomputer ini, yang dikembangkan untuk laboratorium 

energi atom, dapat menangani sejumlah besar data, sebuah kemampuan yang sangat 

dibutuhkan oleh peneliti atom. Mesin tersebut sangat mahal dan cenderung terlalu kompleks 

untuk kebutuhan komputasi bisnis, sehingga membatasi kepopulerannya. Hanya ada dua 

LARC yang pernah dipasang dan digunakan: satu di Lawrence Radiation Labs di Livermore, 

California, dan yang lainnya di US Navy Research and Development Center di Washington 

D.C. Komputer generasi kedua menggantikan bahasa mesin dengan bahasa assembly. 

Bahasa assembly adalah bahasa yang menggunakan singkatan-singakatan untuk 

menggantikan kode biner. 
 

Pada awal 1960-an, mulai bermunculan komputer generasi kedua yang sukses di 

bidang bisnis, di universitas, dan di pemerintahan. Komputer-komputer generasi kedua ini 

merupakan komputer yang sepenuhnya menggunakan transistor. Mereka juga memiliki 

komponen-komponen yang dapat diasosiasikan dengan komputer pada saat ini: printer, 

penyimpanan dalam disket, memory, system operasi, dan program.



 
 
 
 
 
 
 
 
 
 
 

Salah satu contoh penting komputer pada masa ini adalah IBM 1401 yang diterima 

secaa luas di kalangan industri. Pada tahun 1965, hampir seluruh bisnis-bisnis besar 

menggunakan computer generasi kedua untuk memproses informasi keuangan. 
 

Program yang tersimpan di dalam komputer dan bahasa pemrograman yang ada di 

dalamnya memberikan fleksibilitas kepada komputer. Fleksibilitas ini meningkatkan kinerja 

dengan harga yang pantas bagi penggunaan bisnis. Dengan konsep ini, komputer dapa 

tmencetak faktur pembelian konsumen dan kemudian menjalankan desain produk atau 

menghitung daftar gaji. Beberapa bahasa pemrograman mulai bermunculan pada saat itu. 

Bahasa pemrograman Common Business-Oriented Language (COBOL) dan Formula 

Translator (FORTRAN) mulai umum digunakan. Bahasa pemrograman ini menggantikan 

kode mesin yang rumit dengan kata-kata, kalimat, dan formula matematika yang lebih 

mudah dipahami oleh manusia. Hal ini memudahkan seseorang untuk memprogram dan 

mengatur komputer. Berbagai macam karir baru bermunculan (programmer, analyst, dan ahli 

sistem komputer). Industri piranti lunak juga mulai bermunculan dan berkembang pada masa 

komputer generasi kedua ini. 
 

KOMPUTER GENERASI KETIGA 
 

Walaupun transistor dalam banyak hal mengungguli tube vakum, namun transistor 

menghasilkan panas yang cukup besar, yang dapat berpotensi merusak bagian-bagian 

internal komputer. Batu kuarsa (quartz rock) menghilangkan masalah ini. Jack Kilby, seorang 

insinyur di Texas Instrument, mengembangkan sirkuit terintegrasi (IC : integrated circuit) di 

tahun 1958. IC mengkombinasikan tiga komponen elektronik dalam sebuah piringan silikon 

kecil yang terbuat dari pasir kuarsa. Pada ilmuwan kemudian berhasil memasukkan lebih 

banyak komponen-komponen ke dalam suatu chip tunggal yang disebut semikonduktor. 

Hasilnya, komputer menjadi semakin kecil karena komponenkomponen dapat dipadatkan 

dalam chip. Kemajuan komputer generasi ketiga lainnya adalah penggunaan sistem operasi 

(operating system) yang memungkinkan mesin untuk menjalankan berbagai program yang 

berbeda secara serentak dengan sebuah program utama yang memonitor dan 

mengkoordinasi memori komputer. 
 

KOMPUTER GENERASI KEEMPAT 
 

Setelah IC, tujuan pengembangan menjadi lebih jelas: mengecilkan ukuran sirkuit 

dan komponenkomponen elektrik. Large Scale Integration (LSI) dapat memuat ratusan 

komponen dalam sebuah chip. Pada tahun 1980-an, Very Large Scale Integration (VLSI) 

memuat ribuan komponen dalam sebuah chip tunggal.



 
 
 
 
 
 
 
 
 
 

Ultra-Large Scale Integration (ULSI) meningkatkan jumlah tersebut menjadi jutaan. 

Kemampuan untuk memasang sedemikian banyak komponen dalam suatu keping yang 

berukurang setengah keping uang logam mendorong turunnya harga dan ukuran komputer. 

Hal tersebut juga meningkatkan daya kerja, efisiensi dan keterandalan komputer. Chip Intel 

4004 yang dibuat pada tahun 1971 membawa kemajuan pada IC dengan meletakkan 

seluruh komponen dari sebuah komputer (central processing unit, memori, dan kendali 

input/output) dalam sebuah chip yang sangat kecil. Sebelumnya, IC dibuat untuk 

mengerjakan suatu tugas tertentu yang spesifik. Sekarang, sebuah mikroprosesor dapat 

diproduksi dan kemudian diprogram untuk memenuhi seluruh kebutuhan yang diinginkan. 

Tidak lama kemudian, setiap perangkat rumah tangga seperti microwave oven, televisi, dn 

mobil dengan electronic fuel injection dilengkapi dengan mikroprosesor. 
 

Perkembangan yang demikian memungkinkan orang-orang biasa untuk 

menggunakan computer biasa. Komputer tidak lagi menjadi dominasi perusahaan-

perusahaan besar atau lembaga pemerintah. Pada pertengahan tahun 1970-an, perakit 

komputer menawarkan produk komputer mereka ke masyarakat umum. Komputer-komputer 

ini, yang disebut minikomputer, dijual dengan paket piranti lunak yang mudah digunakan 

oleh kalangan awam. Piranti lunak yang paling populer pada saat itu adalah program word 

processing dan spreadsheet. Pada awal 1980-an, video game seperti Atari 2600 menarik 

perhatian konsumen pada komputer rumahan yang lebih canggih dan dapat diprogram. 

 
 
 
 
 
 
 
 

Pada tahun 1981, IBM memperkenalkan penggunaan Personal Computer (PC) untuk 

penggunaan di rumah, kantor, dan sekolah. Jumlah PC yang digunakan melonjak dari 2 juta 

unit di tahun 1981 menjadi 5,5 juta unit di tahun 1982. Sepuluh tahun kemudian, 65 juta PC 

digunakan. Komputer melanjutkan evolusinya menuju ukuran yang lebih kecil, dari komputer 

yang berada di atas meja (desktop computer) menjadi komputer yang dapat dimasukkan ke 

dalam tas (laptop), atau bahkan komputer yang dapat digenggam (palmtop).



 

IBM PC bersaing dengan Apple Macintosh dalam memperebutkan pasar komputer. 

Apple Macintosh menjadi terkenal karena mempopulerkan sistem grafis pada komputernya, 

sementara saingannya masih menggunakan komputer yang berbasis teks. Macintosh juga 

mempopulerkan penggunaan piranti mouse. 
 

Pada masa sekarang, kita mengenal perjalanan IBM compatible dengan pemakaian 

CPU: IBM PC/486, Pentium, Pentium II, Pentium III, Pentium IV (Serial dari CPU buatan 

Intel). Juga kita kenal AMD k6, Athlon, dsb. Ini semua masuk dalam golongan komputer 

generasi keempat. 
 

Seiring dengan menjamurnya penggunaan komputer di tempat kerja, cara-cara baru 

untuk menggali potensial terus dikembangkan. Seiring dengan bertambah kuatnya suatu 

komputer kecil, komputerkomputer tersebut dapat dihubungkan secara bersamaan dalam 

suatu jaringan untuk saling berbagi memori, piranti lunak, informasi, dan juga untuk dapat 

saling berkomunikasi satu dengan yang lainnya. Komputer jaringan memungkinkan 

komputer tunggal untuk membentuk kerjasama elektronik untuk menyelesaikan suatu proses 

tugas. Dengan menggunakan perkabelan langsung (disebut juga local area network, LAN), 

atau kabel telepon, jaringan ini dapat berkembang menjadi sangat besar. 
 

KOMPUTER GENERASI KELIMA 
 

Mendefinisikan komputer generasi kelima menjadi cukup sulit karena tahap ini masih 

sangat muda. Contoh imajinatif komputer generasi kelima adalah komputer fiksi HAL9000 

dari novel karya Arthur C. Clarke berjudul 2001:Space Odyssey. HAL menampilkan seluruh 

fungsi yang diinginkan dari sebuah komputer generasi kelima. Dengan kecerdasan buatan 

(artificial intelligence), HAL dapat cukup memiliki nalar untuk melakukan percapakan dengan 

manusia, menggunakan masukan visual, dan belajar dari pengalamannya sendiri. 
 

Walaupun mungkin realisasi HAL9000 masih jauh dari kenyataan, banyak fungsi-

fungsi yang dimilikinya sudah terwujud. Beberapa komputer dapat menerima instruksi secara 

lisan dan mampu meniru nalar manusia. Kemampuan untuk menterjemahkan bahasa asing 

juga menjadi mungkin. Fasilitas ini tampak sederhan. Namun fasilitas tersebut menjadi jauh 

lebih rumit dari yang diduga ketika programmer menyadari bahwa pengertia manusia sangat 

bergantung pada konteks dan pengertian ketimbang sekedar menterjemahkan kata-kata 

secara langsung. 
 

Banyak kemajuan di bidang desain komputer dan teknologi semkain memungkinkan 

pembuatan komputer generasi kelima. Dua kemajuan rekayasa yang terutama adalah 

kemampuan pemrosesan paralel, yang akan menggantikan model non Neumann. Model non 

Neumann akan digantikan dengan sistem yang mampu mengkoordinasikan banyak CPU 

untuk bekerja secara serempak. Kemajuan lain adalah teknologi superkonduktor yang 

memungkinkan aliran elektrik tanpa ada hambatan apapun, yang nantinya dapat 

mempercepat kecepatan informasi. 
 

Jepang adalah negara yang terkenal dalam sosialisasi jargon dan proyek komputer 

generasi kelima. Lembaga ICOT (Institute for new Computer Technology) juga dibentuk 

untuk merealisasikannya. Banyak kabar yang menyatakan bahwa proyek ini telah gagal, 

namun beberapa informasi lain bahwa keberhasilan proyek komputer generasi kelima ini 

akan membawa perubahan baru paradigma komputerisasi di dunia. Kita tunggu informasi 

mana yang lebih valid dan membuahkan hasil.



 

Dampak Negatif Dari Perkembangan Teknologi 
 

Zaman modern saat ini keberadaan teknologi sudah berikatan erat dengan generasi. 

Benar adanya bahwa perkembangan teknologi yang melejit memiliki segudang manfaat 

tetapi perlu diketahui segudang dampak negatif juga mengikutinya. Sisi gelap teknologi 

media global beserta sajian yang tidak pantas di dalamnya adalah pelaku polusi teknologi 

bagi generasi saat ini. Pribadi yang sebelumnya tinggi, bermoral dan memiliki nilai-nilai 

(values) yang luhur bisa dibuatnya jatuh di jurang tak bermoral tanpa sadar. Selain itu 

Radiasi Gelombang Elektromagnetik dalam teknologi infomasi dan komunikasi yang kurang 

diwaspadai ternyata dapat mempengaruhi lingkungan dan kesehatan generasi. Dampak 

nyata dari teknologi modern di zaman modern akan menjadi dampak transparan bagi 

generasi jika generasi tetap tidak mengetahuinya. 
 

Banyak peneliti di zaman modern seperti saat ini yang telah memunculkan berkas baru 

menyangkut teknologi informasi dan komunikasi yang mengungkap ikut andilnya radiasi 

gelombang elektromagnetik terhadap kesehatan generasi. Radiasi ini juga memunculkan 

polemik baru bagi lingkungan yang terbukti dari beberapa penelitian. Kecanggihan dari 

teknologi seakan sudah banyak membius para generasi. Handphone, televisi, komputer, 

radio dan laptop adalah contoh kecil dari teknologi informasi dan komunikasi yang sudah 

menjadi bagian dari menu kebutuhan sehari-hari generasi masa kini. Yang disayangkan 

adalah banyak generasi sekarang kurang mengetahui berbagai dampak negatif yang 

ditimbulkan oleh alat-alat bersemayamnya radiasi gelombang elektromagnetik ini. 
 

Menurut Riedlinger (2004) terlalu sering melakukan kontak langsung terhadap alat-alat 

dengan radiasi elektromagnetik tinggi dapat mempengaruhi kesehatan, Riedlinger juga 

mengatakan potensi gangguan     kesehatan yang timbul akibat pajanan medan 

elektromagnetik dapat terjadi pada berbagai sistem tubuh, antara lain: Sistem darah, Sistem 

reproduksi, Sistem saraf, Sistem kardiovaskular, Sistem endokrin, Psikologis, dan 

Hipersensitivitas. Sedangkan manifestasi dari hipersensitivitas dikenal pula dengan istilah 

electrical sensitivity, yang menggambarkan gangguan fisiologis berupa tanda dan gejala 

neurologis maupun kepekaan terhadap medan elektromagnetik dengan gejala-gejala yang 

khas. 
 

Sedangkan menurut Dr. Lennart Hardell, Univarsity Hospital Orebro Swedia, Radiasi 

gelombang elektromagnetik dengan aktivitas tinggi dapat memicu kanker otak. Peryataan Dr. 

Lennart Hardell ternyata tak jauh berbeda dengan penelitian National Radiology Protection 

Board-Inggris yang menyatakan bahwa Radiasi dengan intensitas tinggi dapat merusak 

DNA, mengganggu perkembangan otak pada anak & memicu perkembangan Tumor Otak. 

Penelitian dampak radiasi gelombang elektromagnetik lebih lanjut ternyata telah 

memunculkan fakta baru bahwa radiasi gelombang elektromagnetik juga memiliki pengaruh 

terhadap lingkungan. 

Dibuktikan oleh penelitian Wagening University, yang melakukan penelitian pada Wi-Fi 

(Wireless Fidelity) dengan aktivitas radiasi tinggi terhadap tumbuhan, menemukan bahwa 

tumbuhan yang tumbuh di kawasan pemukiman penduduk, tanaman tersebut menderita 

gejala yang berbeda dengan gejala yang disebabkan oleh bakteri ataupun virus tumbuhan 

pada umumnya. Ditambah dari PopSci, 23 November 2010, yang menyatakan gejala-gejala 

yang muncul pada pohon termasuk di antaranya adalah pendarahan, celah di kulit, matinya 

bagian tertentu dari daun, serta pertumbuhan yang abnormal.



 

Meski perlu diadakan penelitian lebih mendalam lagi untuk mengetahui menyangkut 

seberapa jauh efektifitas peralatan proteksi radiasi elektromagnetik dan seberapa besar 

pengaruh terhadap lingkungan, suatu hal yang dapat dipastikan adalah jika dampak negatif 

radiasi gelombang elektromagnetik dianggap angin lewat tanpa adanya perhatian maka akan 

banyak generasi yang terimbas oleh dampak negatifnya.



MODUL 2: 
MICROSOFT WORD 2007 

 
 

Pendahuluan 
 

Microsoft Word 2007 adalah program aplikasi pengolah kata produk Microsoft yang 

merupakan kelanjutan dari versi sebelumnya. Terdapat beberapa fitur terbaru dalam versi 

ini diantaranya adalah fasilitas digital signature, publikasi dokumen ke dalam format PDF 

dan XPS dan beberapa keunggulan lainya. Bagi yang sudah pernah menggunakan versi 

sebelumnya, mungkin agak merasa asing karena terdapat perubahan tampilan/interface 

windows yang ada, tetapi dengan sedikit penyesuaian maka selanjutnya anda akan 

merasakan kelebihan dari tampilan Microsoft Word 2007 ini. 
 

Skenario Kasus 

Anda sebagai user atau pengguna dalam Microsoft Word 2007 ini, dan anda diminta untuk 

mengenali menu-menu dan fitur yang ada serta anda diminta untuk dapat menjalankannya 

dan dapat mengaktifkan menu – menu yang terdapat di dalamnya. 
 

Setelah anda dapat menjalankan Microsoft Word 2007, anda diminta untuk dapat membuat 

dokumen kerja, menyimpan dokumen yang telah dibuat serta memodifikasi, mengedit 

serta menyisipkan objek dalam dokumen. Kemudian anda juga diminta untuk dapat 

megatur layout dokumen yang akan dicetak/diprint. 
 

Selanjutnya anda akan dilatih untuk dapat mengkombinasikan tabel ke dalam dokumen 

kerja kita, kemudian anda juga dapat mengatur format dan style table, serta dapat 

memanfaatkan shape dan image, dan grafik serta diagram untuk memaksimalkan dan 

mempercantik tampilan dokumen anda. 
 

Pada modul terakhir pelajaran kita ini, akan membahas cara menggunakan Mail Merge. Fitur 

Mail Merge ini digunakan untuk mebuat dokumen yang berulang dengan isi yang berbeda, 

contohnya Surat, Formulir, Kwitansi dan lain sebagainya. 



 
 

Modul 1. Membuat Dan Menyimpan Dokumen Kerja 
 

Materi 

Menjalankan 

Microsoft Word 2007. 

Langkah Detailnya 

1. Cara 1 : Klik tombol Start > All Program > Microsoft Office > 

Microsoft Office Word 2007. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Cara 2 : Klik tombol Start > Run > ketikkan “winword” > Enter. 
 
 
 
 
 
 
 
 
 
 
 

Materi 

Pengenalan 

Interface/Tampilan 

Microsoft Word 2007. 

Langkah Detailnya 

1. Pada windows Microsoft Word 2007 yang muncul, terdapat 

beberapa tampilan sebagai berikut (tunjukkan dengan mouse 

anda masing–masing komponen berikut) : 

- Office Button 

- Quick Access Toolbar 

- Title Bar 

- Tabmenu Ribbon 

- Ribbon 

- Status Bar 

- Horizontal Scroll Bar 

- Vertical Scroll Bar 

- Document Area



 
 
 

Office         Quick 

Button      Access 

 

Tab Title 
Menu 

 
Ribbon 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status 

Bar 
 

Materi Langkah Detailnya 

Document 

Area 

Horizontal 

Scroll Bar 
Horizontal 

Scroll Bar 

 

Mengaktifkan Menu-

Menu Pada Microsoft 

Word 2007. 

1. Untuk mengaktifkan Menu Home, coba anda klik tab Menu Home 

pada tab menu atau tekan Alt+H, perhatikan ribbon menu yang 

tampil. 

 
 
 
 
 
 
 
 
 

2. Untuk mengaktifkan Menu Insert, coba anda klik Menu Insert pada 

tab menu atau tekan Alt+N, perhatikan ribbon menu yang tampil.



 
 

3. Untuk mengaktifkan Menu Page Layout, coba anda klik tab Menu 

Page Layout pada tab menu atau tekan Alt+P, perhatikan ribbon 

menu yang tampil. 
 
 
 
 
 
 
 
 
 

4. Untuk mengaktifkan Menu References, coba anda klik tab Menu 

References pada tab menu atau tekan Alt+S, perhatikan ribbon menu 

yang tampil. 
 
 
 
 
 
 
 
 
 

5. Untuk mengaktifkan Menu Mailing, coba anda klik tab Menu Mailing 

pada tab menu atau tekan Alt+M, perhatikan ribbon menu yang 

tampil . 
 
 
 
 
 
 
 
 

6. Untuk mengaktifkan Menu Review, coba anda klik tab Menu Review 

pada tab menu atau tekan Alt+R, perhatikan ribbon menu yang 

tampil. 
 
 
 
 
 
 
 
 
 

7. Untuk mengaktifkan Menu View, coba anda klik tab Menu View pada 

tab menu atau tekan Alt+W, perhatikan ribbon menu yang tampil.



 
 
 
 
 
 
 
 
 

8. Untuk mengaktifkan Menu Design, coba anda klik tab Menu Design 

pada tab menu atau tekan Alt+J kemudian tekan T, perhatikan 

ribbon menu yang tampil. 
 
 
 
 
 
 
 
 
 

9. Untuk mengaktifkan Menu Layout, coba anda klik tab Menu Layout 

pada tab menu atau tekan Alt+J kemudian tekan L, perhatikan ribbon 

menu yang tampil. 
 
 
 
 
 
 
 
 
 
 

Tip : Jika mouse anda terdapat tombol scrollnya, maka anda dapat 

berpindah dari satu menu ke menu lainnya dengan menggeser 

tombol scroll yang ada pada mouse anda. 

Tombol Scroll



 
 

Materi 

Membuat Dokumen 

Baru Dalam Microsoft 

Word 2007. 

Langkah Detailnya 

1. Klik Office Buttom > New. 

2. Pada Kotak Dialog yang muncul Pilih > Blank Document > klik tombol 

Create. 

 
 
 
 
 
 
 
 
 
 
 
 

3. Untuk membuat dokumen baru dari Templates, pilih pada bagian 

kelompok Templates, Klik Tombol Create. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada windows yang muncul, letakkan kursor dimana anda akan mulai 

mengetik.



– 

Modul Aplikasi Komputer Microsoft office word 2007 

 

Kemudian ketikkanlah teks di bawah ini (ketikan teksnya saja. Untuk fomat dokumennya 

akan dibahas pada latihan berikutnya). 
 

TIPS MEMILIH NAMA ANAK– NAMA BAYI 



1. Pilihlah nama yang baik 

Mungkin ada ungkapan yang menyatakan “Apalah arti sebuah nama”. 
Namun, hendaknya setiap orang tua menyadari bahwa nama anak atau nama 

bayi sangatlah penting bagi anak atau bayi itu. Nama anak atau nama bayi 

adalah identitas. Anak atau bayi Anda akan dipanggil dengan nama tersebut oleh 

semua orang. Apalah jadinya jika nama yang Anda berikan kepada anak atau 

bayi tidak bagus. 
 
 

2. Pilihlah nama yang mudah dieja 

Nama anak atau nama bayi Anda akan sering disebut / dipanggil. Nama 

anak atau nama bayi Anda juga akan sering ditulis 

untuk berbagai keperluan. Karena itulah, 

permudah orang untuk memanggil nama anak Tip dan Trik 

atau nama bayi Anda dengan cara memilih nama Memilih Nama 

yang mudah dieja. Catik Untuk Anak 
 
 

3. Pilih nama yang memiliki arti baik 

Dalam agama, nama berarti doa. Artinya nama anak atau nama bayi adalah doa 

baginya. Karena itu, pilihlah nama anak atau nama bayi Anda dengan baik. 
 

Jangan terlalu panjang 
 

Walaupun nama sangat penting bagi anak atau bayi Anda, namun janganlah 

memberi nama terlalu panjang. Cukup 2 hingga 3 kata saja. 
 

Jangan memilih nama yang Anda tidak mengetahui artinya 
 

Hindari memilih nama anak atau nama bayi yang Anda sendiri tidak mengetahui 

artinya. Jika nama tersebut ternyata memiliki arti baik sih, tidak mengapa. Namun, 

jika ternyata nama yang Anda pilih memiliki arti yang buruk, bagaimana ?



 
 

Materi 

Menyimpan Dokumen 

Kerja. 

Langkah Detailnya 

1. Setelah teks selesai anda ketik, klik Office Button. 

2. Pilih Save atau Save As (untuk menyimpan dengan nama yang beda 

dengan nama sebelumnya). 

3. Pilih Word Document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada windows yang muncul, pilih folder Document, ketikkan nama 

filenya pada File name “Tips Nama Cantik”. Pilih Word Document 

pada Save as type. 
 

5. Klik tombol Save.



 
 

Materi 

Menutup 

Kerja. 

Langkah Detailnya 

Dokumen 1. Klik Office Button > Close (Ctrl + W).



 
 

Tugas 

Tugas Modul 1. 

Petunjuk Pengerjaan Tugas 

Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama 

 “Tugas Modul 1” .  
 
 
 

Visi Indonesia Sehat 2010 
 

Visi Indonesia Sehat 2010 yang telah dirumuskan oleh Dep.Kes (1999) menyatakan bahwa, 

gambaran masyarakat Indonesia dimasa depan yang ingin dicapai melalui pembangunan 

kesehatan adalah masyarakat, bangsa dan negara yang ditandai oleh penduduknya hidup 

dalam lingkungan dan dengan perilaku yang sehat, memiliki kemampuan untuk menjangkau 

pelayanan kesehatan yang bermutu secara adil dan merata, serta memiliki derajat kesehatan 

yang setinggi-tingginya diseluruh wilayah Republik Indonesia. 
 

Pengertian sehat meliputi kesehatan jasmani, rohani, serta sosial dan bukan hanya keadaan 

bebas dari penyakit, cacat dan kelemahan. Masyarakat Indonesia yang dicita citakan adalah 

masyarakat Indonesia yang mempunyai kesadaran, kemauan dan kemampuan untuk hidup 

sehat sehingga tercapai derajat kesehatan yang setinggi-tingginya, sebagai salah satu unsur 

dari pembangunan sumber daya manusia Indonesia seutuhnya. 
 

Visi tersebut telah tiga tahun yang lalu berhasil dirumuskan oleh Departemen Kesehatan RI 

yang mestinya telah dijabarkan kedalam program kerja yang lebih bersifat operasional untuk 

mencapai visi itu. Beberapa tahun lagi kita akan mencapai tahun 2010, dan saat itu kita tentu 

akan menyaksikan bersama apakah gambaran tersebut akan menjadi kenyataan?. Namun yang 

perlu kita renungkan visi Indonesia sehat 2010 sebenarnya visi siapa? Bila itu merupakan visi 

Departemen Kesehatan RI saja atau yang dirumuskan hanya oleh beberpa pejabat saja 

sedangkan dalam cita citanya adalah masyarakat Indonesia yang mempunyai kesadaran, 

kemauan dan kemampuan untuk hidup sehat. 
 

Pertanyaanya berikutnya adalah bagaimana masyarakat Indonesia ikut merasa meiliki terhadap 

visi itu karena ia ditempatkan sebagai subyek yang harus berubah. Namun jika itu adalah 

perwujudan dari visi bangsa Indonesia, pertanyaanya adalah sejauh mana keterlibatan 

masyarakat/bangsa Indonesia ini terlibat dalam merumuskan visi itu sehingga mereka juga 

punya komitment untuk merealisasikan visi tersebut. Bila kita lupakan saja itu visi siapa yang 

jelas seperti yang saya uraikan sebelumnya baha status kesehatan bangsa Indonesia merupakan 

resultanste upaya bersama, maka yang harus kita upayakan adalah bagaimana visi Indonesia 

2010 sehat, itu menjadi milik dan bagian dalam kehidupan bangsa Indonesia. Tanpa 

masyarakat dan sektor lain merasakan itu, maka komitmennya untuk ikut mewujudkan visi 

tersebut juga akan lemah, karena untuk mewujudkan visi dibutuhkan komitmen semua pihak 

(stakeholder). 
 

Akhirnya kita sebagai bangsa Indonesia perlulah merenung sejenak untuk membayangkan 

dapatkan visi mulia “Indonesia Sehat 2010 “ itu akan terwujud. Tentunya kita tidak berharap 

bahwa pada saatnya nanti visi itu akan menjadi sekedar jargon yang terlewatkan dan terlupakan 

begitu saja. Sementara dunia telah metapkan status kesehatan masyarakat menjadi salah satu 

komponen Human Development Index ( HDI ) yaitu indikator kemajuan kualitas SDM suatu 

bangsa. 



 
 

Modul 2. Mengedit Dokumen Kerja Dan Memformat Huruf 
 

Materi 

Membuka Dokumen 

Yang Telah Disimpan. 

Langkah Detailnya 

1. Klik Office Button > Open. 

 
 
 
 
 
 
 

2. Pada kotak dialog yang muncul, pilih folder yang akan dibuka filenya 

yaitu folder “Documents”. 

3. Pilih nama filenya “Tips Nama Cantik”. 
4. Klik tombol Open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 

Memilih Teks Yang 

Akan Diformat/Edit. 

Langkah Detailnya 

1. Setelah file terbuka, coba Klik drag pada teks untuk memilih bebas.



 
 

2. Sekarang Double klik untuk memilih satu kata. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Coba klik tiga kali pada paragraf untuk memilih satu paragraf. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Sekarang coba Ctrl+klik di awal kalimat untuk memilh satu kalimat. 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Kemudian tekan Ctrl+A pada keyobard untuk memilih semua teks 

 dalam dokumen. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Memindahkan Dan 

Menduplikasi Teks. 

1. Pilih/seleksi paragraf 1, klik icon cut (Ctrl+X) pada tab ribbon 

clipboard. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Letakkan kursor diakhir dokumen. Kemudian Klik icon Paste (Ctrl + V).



 
 

3. Untuk menduplikasi teks/ mengkopi, pilih paragraf terakhir, klik icon 

Copy (Ctrl +C). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Letakkan kursor di bawah baris ke 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Kemudian klik icon Paste (Ctrl + V). 
 

Memformat 

Huruf/Font. 

1. Pilih judul dokumen, klik pada bagian tab ribbon font, pilih jenis huruf 

(font) Century , ukuran huruf (Size) 14, klik icon Style huruf (Ctrl+B, 

Ctrl+I, Ctrl+U).



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik icon menu Change Case, ganti bentuk huruf menjadi 

UPPERCASE. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Untuk membuat efek huruf, klik icon menu font. 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, centang Shadow pada bagian Effect, 

klik tombol OK.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Mengatur 

Paragraf. 

Langkah Detailnya 
 

Perataan 1. Teks judul masih dalam keadaan terpilih, pada bagian paragraph, klik 

icon rata tengah (Ctrl+E). Coba lakukan untuk paragraf yang lain 

sesuai dengan contoh dokumen kita, rata seimbang (Ctrl +J), rata kiri 

(Ctrl+L), rata kanan (Ctrl+R). Font Size selain judul 12.



M W ISALNYA PEN I IKAN APAT E BANTU SIS A UNTUK 

M EN APATKAN PEN ETAHUAN AN KETERA PILAN YANG IPERLUKAN UNTUK HI U  

M M M M AN BERK PETISI ALA EK N I YANG K PETITIF  

 
 

Tugas 
 

Tugas Modul 2. 

Petunjuk Pengerjaan Tugas 
 

Buatlah format dokumen di bawah ini dengan ketentuan: 

Jenis huruf : Calibri 

Font size : 12 

Dan buatlah fomat huruf dan paragraf seperti pada soal. Setelah selesai 

simpan dengan nama “Tugas Modul 2”. 
 
 

PENDIDIKAN SEBAGAI INVESTASI JANGKA PANJANG 
 

Profesor Toshiko Kinosita Mengemukakan Bahwa Sumber Daya Manusia Indonesia Masih Sangat 

Lemah Untuk Mendukung Perkembangan Industri Dan Ekonomi. Penyebabnya Karena Pemerintah 

Selama Ini Tidak Pernah Menempatkan Pendidikan Sebagai Prioritas Terpenting. Tidak 

Ditempatkannya Pendidikan Sebagai Prioritas Terpenting Karena Masyarakat Indonesia, Mulai 

Dari  Yang  Awam Hingga  Politisi  Dan  Pejabat  Pemerintah, Hanya Berorientasi  Mengejar  Uang 

Untuk Memperkaya Diri Sendiri Dan Tidak Pernah Berfikir Panjang. 

 

PENDAPAT GURU BESAR UNIVERSITAS WASEDA JEPANG TERSEBUT SANGAT MENARIK 

UNTUK DIKAJI MENGINGAT SAAT INI PEMERINTAH INDONESIA MULAI MELIRIK 

PENDIDIKAN SEBAGAI INVESTASI JANGKA PANJANG, SETELAH SELAMA INI PENDIDIKAN 

TERABAIKAN. Salah satu indikatornya adalah telah disetujuinya oleh MPR untuk 

memprioritaskan anggaran pendidikan minimal 20 % dari APBN atau APBD. Langkah ini 

merupakan awal kesadaran pentingnya pendidikan sebagai investasi jangka pangjang. 
 
 
 

. 
 

, pendidikan adalah alat untuk perkembangan ekonomi dan bukan 

sekedar pertumbuhan ekonomi. Pada praksis manajemen pendidikan modern, salah satu 
dari lima fungsi pendidikan adalah fungsi teknis-ekonomis baik pada tataran individual 

hingga tataran global. Fungsi teknis-ekonomis merujuk pada kontribusi pendidikan untuk 

perkembangan ekonomi.M ISALNYA PENDIDIKAN DAPATM E BANTU SIS A UNTUK 
M ENDAPATKAN PENGETAHUAN DAN KETERA PILAN YANG DIPERLUKAN UNTUK HIDUP 

DAN BERKO PETISI DALA EKONO I YANG KO PETITIF.



 
 

Modul 3. Memformat Paragraf, Bullet Dan Numbering, Drop Cap Dan 

Spasi Baris 
 

Materi 
 

Membuat Numbering. 

Langkah Detailnya 
 

1. Pilih teks baris ke dua dokumen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik icon pada ribbon paragraph, kemudian pilih jenis Number 

Aligment left. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Tekan tombl Ctrl + B. 

5. Lakukan untuk teks yang mempunyai fomat numbering yang sama. 
 

Materi 

Membuat Bullet. 

Langkah Detailnya 

1. Pilih teks “Jangan terlalu panjang” kemudian tekan Ctrl pilih teks 

“Jangan memilih nama …… “.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik icon menu Bullet pada ribbon paragraph > Define New Bullet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Pada kotak dialog yang muncul klik Symbol. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Ganti font menjadi Wingdings , kemudian pilih jenis simbolnya, klik 

OK, kemudian klik tombol OK kembali.



P 

J 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 

 Membuat Drop Cap.  Buat dokumen seperti di bawah ini :  
 

ada hakikatnya setiap penelitian kuantitatif dalam ilmu-ilmu sosial menerapkan 

filosofi yang disebut deducto hipothetico verifikatif artinya, masalah penelitian 

dipecahkan dengan bantuan cara berpikir deduktif melalui pengajuan hipotesis yang 

dideduksi dari teori-teori yang bersifat universal dan umum, sehingga kesimpulan dalam 

bentuk hipotesis inilah yang akan diverifikasi secara empiris melalui cara berpikir induktif 

dengan bantuan statistika inferensial. 
 

adi, hipotesis yang diajukan peneliti, setelah membaca teori-teori yang relevan 

merupakan jawaban sementara terhadap masalah yang diajukan. Oleh karena itu, 

penggunaan kata tanya dalam perumusan masalah harus juga diperhatikan dengan 

mempertimbangkan jawaban yang logis dalam hipotesis, sehingga tidak mungkin 

peneliti dapat mengajukan hipotesis manakala kata tanya yang digunakan dalam 

perumusan masalah ilmiah adalah kata tanya seperti “sejauh manakah” atau “seberapa 

besarkah,” karena jawabannya sejauh itu atau sebesar itu.



 
 

1. Buatlah Dokumen baru (Ctrl + N). 

2. Letakkan kursor di awal dokumen. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Ketikkanlah teks tersebut sampai selesai. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Letakkan kursor di awal baris pertama paragraf 1.



 
 

5. Klik tab menu Insert kemudian pilih icon menu Drop Cap > Drop Cap 

Options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Pada kotak dialog drop cap, pilih icon Dropped, Font : Arial , Line to 

drop : 3, Distance from text : 0.1 cm. Kemudian klik tombol OK. 
 
 
 
 
 
 
 
 
 
 
 

7. Kemudian perhatikan hasilnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Letakkan kembali kursor pada awal paragraf 2 baris 1.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Kemudian klik kembali tab menu Insert > Drop Cap > Drop cap option. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Pada kotak dialog drop cap, pilih icon In Margin, Font : Calibri , Line 

to drop : 4, Distance from text : 0.1 cm. Kemudian klik tombol OK.



 
 

11. Perhatikan perbedaanya. Kemudian simpan dokumen anda dengan 

nama “Drop Cap”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 

Mengatur Jarak 

Baris/Spasi Baris. 

Langkah Detailnya 

1. Pilih/seleksi semua teks (Ctrl+A), klik tab Home menu. Klik tombol 

Paragraph dialog box pada ribbon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Pada kotak dialog yang muncul, Klik tab indents and spacing , 

kemudian tentukan lebar spasi 1,5 lines pada line spacing. Klik tombol 

OK. Perhatikan hasilnya.





A 

 
 

Tugas 

Tugas Modul 3. 

Petunjuk Pengerjaan Tugas 

Untuk lebih memahami materi pada modul yang telah kita pelajari, 

buatlah dokumen dengan ketentuan seperti berikut : 

Jenis huruf , sesuaikan dengan tampilan soal. Formatlah huruf, paragraf 

dan bullet and numbering seperti soal. Setelah selesai simpan dengan 

nama “Tugas Modul 3”. 
 
 

Antioksidan dan Radikal Bebas 







ntioksidan adalah senyawa yang mencegah proses oksidasi oleh radikal bebas. 

Radikan beas adalah suatu atom atau molekul yang bermuatan positif atau negate. 

Dimana sifat dari atom atau molekul yang bermuatan tadi sangat reaktif dan tidak 

stabil, karena akan berusaha menetralisir dirinya dengan cara menarik electron dari molekul 

atau atom yang ada di dekatnya.sehingga terjadi reaksi berantai. 
 

Sifat dari radikal bebas tadi akan merusak sel-sel bahkan sampai ke inti sel yang bisa 

mengakibatkan terjadinya mutasi gen sehingga menyebabkan timbulnya kanker. 
 

Antioksidan Dapat Berupa : Vitamin, Mineral Atau Enzim 
 

Sumber Radikal Bebas 
 

1. Metabolisme tubuh kita sendiri 

2. Pencemaran udara 

3. Bahan kimia dari makanan dan air 

4. Alkohol 

5. Rokok 

6. Radiasi ultra violet 

7. Obat-obatan 

8. Stress 
 

Kerusakan akibat radikal bebas 
 

Penuaan yang cepat 

Penyakit jantung 

Sistem kekebalan tubuh menurun 

Katarak 

Rematik 

Kanker 

Kencing manis / Diabetes 
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Modul 4. Mengatur Jarak Paragraf, Orientasi Halaman Dan 

Menyisipkan Tanggal 
 

Materi 
 

Mengatur Jarak Antar 

Paragraf. 

Langkah Detailnya 
 

1. Pilih semua teks kembali, klik tab Home menu, klik tombol Paragraph 

dialog box pada ribbon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Pada kotak dialog yang muncul, Klik tab indents and spacing , pada 

bagian spacing isikan Before 5, After 5. Klik tombol OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Mengatur Jarak 

Indentasi (Jarak Teks 

Terhadap Margin). 

Langkah Detailnya 
 

1. Pilih kembali semua teks. Klik tab Home menu. 

2. Klik tombol Paragraph dialog box pada ribbon. 

3. Klik tab indents and spacing , pada Indentation, isikan Left = 1, Right = 

1. Klik OK.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian, klik 3 kali paragraf 1, tekan dan tahan Ctrl , klik 3 kali 

paragraf 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Klik tombol Paragraph dialog box pada ribbon, pada bagian Special, 

pilih first line, isikan pada By = 1. Klik tombol OK.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Coba anda tekan tombol Ctrl+Z, kemudian tekan tombol Ctrl+Y. 

Perhatikan Perubahannya. 
 

Materi 
 

Mengatur Margin, 

Ukuran dan Orientasi 

Halaman/ Page Size. 

Langkah Detailnya 
 

1. Klik tab Menu Page Setup. 

2. Pilih tombol Page Setup Dialog Box.



 
 
 
 
 
 
 
 
 

3. Pada kotak dialog Page setup, klik tab Margin dan isikan nilai margin 

Top : 3, Left : 4, Button : 3, Right : 3. 

4. Pada bagian Orientation pilih Portrait. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Untuk mengatur jenis kertas/ ukuran kertas, klik tab Peper. Pilih jenis 

kertas A4 pada Peper Size. Klik tombol OK.



 
 

Materi 
 

Menambahkan 

Tanggal Dalam 

Dokumen. 

Langkah Detailnya 
 

1. Buka kembali file Tugas Modul 1. 

2. Letakkan kursor di tengah di bawah judul. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Klik tab menu Insert > Date&Time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, pilih fomat tanggalnya (lihat gambar) 

pada bagian Available format, Language : Indonesia, aktifkan Update 

Automatically. Kemudian klik OK.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Perhatikan hasilnya. Kemudian tekan tombol Ctrl+S.
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Tugas 
 

Tugas Modul 4. 

Petunjuk Pengerjaan Tugas 
 

Untuk lebih memahami materi pada modul yang telah kita pelajari, 

buatlah dokumen dengan tampilan seperti berikut. Setelah selesai 

simpanlah dengan nama “Tugas Modul 4”. 
 
 
 

 “ Anemia Pernisiosa dan Pengobatannya” 
 

Anemia pernisiosa adalah anemia yang terjadi akibat kekurangan vitamin B12. Pada anemia 

ini, sel darah merah yang diproduksi, lebih besar dari biasanya. Akibatnya, sel darah 

tersebut sulit untuk keluar dari di sum-sum tulang belakang. 
 

Vitamin B12 merupakan salah satu anggota kelompok vitamin B. Vitamin ini banyak 

ditemukan pada daging, ikan, telur, susu, dan produk susu lainnya. 
 

Kekurangan vitamin ini dapat terjadi akibat : 
 

Kurang asupan vitamin B12 dari makanan, misalnya pada penganut vegetarian, orang 

tua, atau pecandu alkohol. 

Kurangnya intrinsik faktor, yaitu protein yang membantu penyerapan vitamin B12 di 

lambung. Faktor ini merupakan penyebab tersering anemia pernisiosa. 

Gangguan di usus seperti penyakit Crohn dan infeksi usus. 
 
 

Prinsip pengobatan anemia pernisiosa adalah untuk mencukupi kebutuhan vitamin B12 yang 

kurang dalam tubuh. 
 

Sedangkan tujuan pengobatan adalah : 
 

Untuk menyembuhkan anemia melalui pemberian vitamin B12. 

Untuk mencegah timbulnya komplikasi, seperti kerusakan jantung atau saraf. 

Mengobati penyakit dasarnya jika anemia pernisiosa disebabkan oleh penyakit 

tertentu. 
 

Setelah pemberian suntikan atau tablet vitamin B12, gejala akan membaik dalam beberapa 

hari. 

Suntikan pada awalnya dapat diberikan setiap hari atau setiap minggu, kemudian sekali 

sebulan. Suntikan dapat juga dikombinasikan dengan tablet. 

Jika anemia pernisiosa disebabkan oleh infeksi usus, biasanya penderita akan diberi 

antibiotik. Jika ada gangguan di usus halus, mungkin dibutuhkan pembedahan. Tetapi, jika 

anemianya terjadi akibat kurang makan makanan bervitamin B12, maka pola makan harus 

diperbaiki.

http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin
http://www.formulabisnis.com/?id=badrudin


Modul Aplikasi Komputer Microsoft office word 2007 

 

Modul 5. Membuat Bingkai Dokumen Dan Pangaturan Tabulasi 
 

Materi 
 

Membuat Bingkai 

Halaman, Paragraf 

Dan Teks. 

Langkah Detailnya 
 

1.Untuk Membuat Bingkai halaman, letakkan kursor pada halaman 1. 

2. Pilih tab menu Page Layout. 

3. Klik Page Border. 

 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, klik tab Page Border. 

5. Pada bagian Setting, pilih Box, pada bagian Style, pada bagian Art pilih 

Jenis bingkai sesuai contoh dokumen, Width : 30. 

6. Pada Apply to, pilih Whole document untuk menerapkan bingkai pada 

seluruh halaman, first page only untuk halaman pertama saja. Klik 

tombol Option. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Pada kotak dialog yang muncul, pilih text pada Measure from agar 

bingkai rapat ke teks. Klik tombol OK.
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Membuat Bingkai Paragraf Dan Teks/Kata. 

1. Pilih teks baris kedua. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Home, klik icon menu Border and Shading pada ribbon 

Paragraph.
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3. Klik tab Border, pada bagian Setting pilih Box, Style : Pilih garis sesuai 

contoh, Color: Automatic, Width: 3. 

4. Pada Aplly to pilih text. Klik OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Coba anda lakukan untuk teks lain yang mempunyai format sama.
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Membuat Shading Teks. 
 

1. Pilih teks seperti terlihat di bawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Aktifkan kembali kotak dialog Border and Shading (lihat langkah 

sebelumnya) . 

3. Klik tab Shading, pada bagian Fill pilih warna biru, Petterns pilih Style 

25%, Color : pilih abu–abu, pada Apply to pilih Paragraph. Klik OK.
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Materi 
 

Menggunakan Menu 

Tab. 

Langkah Detailnya 
 

1. Ketikkanlah teks berikut ini. 

 

DAFTAR ISI 
 
 

LEMBARAN JUDUL .............................................................................................. 

LEMBARAN PENGESAHAN SKRIPSI ...................................................................... 

LEMBARAN PERSETUJUAN UJIAN ........................................................................ 

ABSTRAK ......................................................................................................... 

KATA PENGANTAR .............................................................................................. 

DAFTAR ISI ......................................................................................................... 

DAFTAR GAMBAR ............................................................................................... 

DAFTAR TABEL.................................................................................................... 
 

BAB I : PENDAHULUAN 

Latar Belakang Masalah .......................................................................... 

Identifikasi dan Batasan Masalah ........................................................... 

Perumusan Masalah................................................................................ 

Tujuan dan Manfaat Penelitian............................................................... 

Kerangka Pemikiran ................................................................................ 

Hipotesis.................................................................................................. 

Sistematika Penulisan ............................................................................. 

BAB II : URAIAN TEORITIS 

Defenisi Laporan Keuangan .................................................................... 

Tujuan dan Manfaat Laporan Keuangan................................................. 

Neraca dan Laporan Laba Rugi................................................................
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2. Pilih semua teks kecuali judulnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Klik tab menu Home, klik icon menu Paragraph, pada kotak dialog 

yang mucul klik tombol Tabs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog tabs, isikan tab stop posisition : 2 cm, Aligment : 

Left, Leader : None, kemudian klik tombol Set.
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5. Untuk membuat tabs/perataan yang ke 2, isikan Tab stop posisition : 

14 cm, Aligment : Right, Leader : pilih no 2, kemudian klik tombol Set. 

Kemudian klik tombol OK, perhatikan perubahannya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Kemudian letakkan kursor di awal baris di bawah “BAB I 

PENDAHULUAN” tekan tombol Tab sekali pada keyboard. Lakukan 

untuk meratakan teks yang lain (lihat perataan pada soal).
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7. Kemudian simpan dengan nama “Daftar Isi”. 
 

Materi 

Menghapus 

Tabulasi/Tab Dalam 

Dokument. 

Langkah Detailnya 

1. Pilih kembali semua teks daftar isi, kecuali judulnya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Buka kembali kotak dialog tab (lihat pada materi sebelumnya). 

3. Pada kotak dialog tab, klik tombol Clear All.
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4. Klik tombol OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Membuat Tabulasi 

Menggunakan Ruler. 

Langkah Detailnya 
 

1. Buka kembali file “Tugas Modul 1”. 
2. Seleksi paragraf 1 dan 2.
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3. Klik icon segi tiga “First line Indent” pada ruler, kemudian tahan tarik 

ke angka 1, kemudian lepas. Perhatikan perubahannya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian pilih kembali paragraf 3 sampai dengan paragraf terakhir. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Klik icon menu “Hanging Indent”, kemudian tahan dan geser ke angka 

1 pada ruler. Kemudian lepas, lihat perubahannya.
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6. Kemudian seleksi kembali paragraf 1 sampai dengan paragraf terakhir, 

kemudian tekan tombol Ctrl+J. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Kemudian tekan tombol Ctrl+S, untuk menyimpan dokumen kita.
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Tugas 

Tugas Modul 5. 

Petunjuk Pengerjaan Tugas 

Untuk lebih memahami materi pada modul yang telah kita pelajari, 

buatlah dokumen/ sertifikat dengan tampilan seperti berikut (gunakan 

bingkai sesuai yang anda inginkan). Setelah selesai simpanlah dengan 

nama “Tugas Modul 5”.
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Modul 6. Mencari Teks, Halaman, Menggabungkan Dokumen Dan 

Menggunakan Format Kolom 
 

Materi 
 

Mencari (Find) dan 

Mengganti (Replace) 

Teks. 

Langkah Detailnya 
 

1. Buka kembali file “Tips Nama Cantik. Klik tab menu Home, sorot pada 

bagian Editing pada ribbon. Kemudian klik icon Find (Ctrl+F). 

 
 
 
 
 
 
 
 

2. Pada kotak Find and Replace, klik tab Find, pada Find what ketikkan 

“anda”, klik tombol Find in pilih Main Document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian, klik tab Replace. 

5. Pada Replace width, ketikkan”Saudara”, kemudian klik Replace All. Jika 

muncul peringatan klik Yes. Lihat perubahannya.
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Materi 
 

Berpindah Ke 

Halaman Tertentu. 

Langkah Detailnya 
 

1. Masih menggunakan file ”Tips Nama Cantik”. 
2. Letakkan kursor di awal paragraf ke 2, kemudian tekan Ctrl + Enter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Kemudian letakkan kursor kembali pada awal paragraf 3. Tekan 

kembali Ctrl + Enter. 

4. Klik tab menu Home. Sorot pada bagian ribbon Editing, kemudian klik 

tanda panah pada tombol Find. 
 
 
 
 
 
 
 
 
 

5. Kemudian pilih Go to (Ctrl + G).
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6. Pada kotak dialog yang muncul, pada bagian Go to what pilih Page, 

pada bagian Enter page number isikan 1, kemudian klik tombol Go to. 
 
 
 
 
 
 
 
 
 
 
 
 

7. Maka kursor akan berpindah ke halaman pertama. Klik tombol Close 

kemudian tutup dokumen tanpa melakukan penyimpanan. 
 

Materi 
 

Menggabungkan Dua 

Dokumen Atau Lebih. 

Langkah Detailnya 
 

1. Buka file dokumen “Daftar Isi” dan buka kembali file dokumen “Tips 

Nama Cantik “ 

2. Pilih semua teks dokumen “Tips Nama Cantik” (Ctrl + A). 

3. Klik tombol copy pada ribbon Clipboard (Ctrl +C).
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3. Letakkan kursor diakhir dokumen “Daftar Isi”. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Klik tombol Paste pada ribbon Clipboard (Ctrl +V). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Simpan (Save As) dengan nama ”Gabung File” 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menggunakan Format 

Kolom Dalam 

Dokumen. 

Langkah Detailnya 
 

1. Buka kembali file “Tugas Modul 1”. 
2. Seleksi paragraf 1 sampai dengan paragraf terakhir.
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3. Kemudian klik icon menu Page Layout > Columns > More Columns. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog kolom yang muncul, isikan Number of Columns : 3, 

Spacing : 0,1 cm.
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5. Kemudian klik tombol OK. Perhatikan hasilnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip : Untuk lebih memahami materi ini, anda dapat melihat video tutorial 

“Magic 3 : Kolaborasi Satu dokumen Rame–rame” di website 

“www. videobelajar.com”.
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Tugas 
 

Tugas Modul 6. 

Petunjuk Pengerjaan Tugas 
 

Buatlah dokumen seperti di bawah ini (jenis huruf bebas). Setelah selesai 

simpan dengan nama “Tugas Modul 6”. 
 

Membuka Catatan Sejarah: Detik-Detik Proklamasi, 17 Agustus 1945 
 

Proklamasi Kemerdekaan, yang kita 
peringati setiap tanggal 17 Agustus, adalah 
sebuah peristiwa     bersejarah     bagi bangsa 
Indonesia      . Proklamasi, telah     mengubah 
perjalanan sejarah, membangkitkan rakyat dalam 
semangat kebebasan. Merdeka dari segala 
bentuk penjajahan. 

Bagaimanakah sesungguhnya, 
peristiwa yang terjadi 61 tahun yang 
lalu itu. Mari kita buka kembali catatan 
sejarah sekitar            Proklamasi 
Kemerdekaan            17            Agustus 
1945.Perdebatan Proklamasi, ternyata 
didahului      oleh perdebatan hebat 
antara     golongan     pemuda     dengan 
golongan tua. Baik golongan tua 

maupun golongan muda, sesungguhnya 
sama-sama menginginkan secepatnya dilakukan 
Proklamasi Kemerdekaan dalam suasana 
kekosongan kekuasaan dari tangan pemerintah 
Jepang.       Hanya saja,       mengenai cara 
melaksanakan proklamasi itu terdapat perbedaan 
pendapat.     Golongan tua,     sesuai      dengan 
perhitungan     politiknya,     berpendapat     bahwa 
Indonesia dapat merdeka tanpa pertumpahan 
darah, jika tetap bekerjasama dengan Jepang. 

Karena itu, untuk memproklamasikan 
kemerdekaan, diperlukan suatu revolusi yang 
terorganisir. Soekarno dan Hatta, dua tokoh 
golongan tua,      bermaksud membicarakan 
pelaksanaan Proklamasi Kemerdekaan dalam 
rapat                  Panitia 
Persiapan 
Kemerdekaan 
Indonesia (PPKI). 
Dengan      cara itu, 
pelaksanaan 
Proklamasi 
Kemerdekaan       tidak 
menyimpang          dari 
ketentuan pemerintah 
Jepang. Sikap inilah yang tidak disetujui oleh 
golongan pemuda. Mereka menganggap, bahwa 
PPKI adalah badan buatan Jepang. Sebaliknya, 
golongan pemuda menghendaki terlaksananya 
Proklamasi Kemerdekaan itu, dengan kekuatan 
sendiri. Lepas sama sekali dari campur tangan 
pemerintah Jepang. 

Perbedaan pendapat ini, mengakibatkan 
penekanan-penekanan golongan pemuda 
kepada golongan tua yang mendorong mereka 

melakukan &ldquo;aksi penculikan&rdquo; 
terhadap diri     Soekarno-Hatta (lihat Marwati 
Djoened Poesponegoro, ed.1984:77-81). 

Tanggal 15 Agustus 1945, kira-kira pukul 
22.00, di Jalan Pegangsaan Timur No. 56 
Jakarta,      tempat      kediaman      Bung      Karno, 

berlangsung perdebatan 
serius                   antara 
sekelompok       pemuda 
dengan     Bung     Karno 
mengenai      Proklamasi 

Kemerdekaan 
sebagaimana dilukiskan 
Lasmidjah              Hardi 
(1984:58);           Ahmad 
Soebardjo (1978:85-87) 

sebagai berikut: 
“ Sekarang Bung, sekarang! Malam ini 

juga kita kobarkan revolusi !” kata Chaerul Saleh 
dengan meyakinkan Bung Karno bahwa ribuan 
pasukan bersenjata sudah siap mengepung kota 
dengan maksud mengusir tentara Jepang. “ Kita 
harus segera merebut kekuasaan ! ” tukas 
Sukarni berapi-api. “ Kami sudah siap 
mempertaruhkan jiwa kami ! ” seru mereka 
bersahutan. Wikana malah berani mengancam 
Soekarno dengan pernyataan; “ Jika Bung Karno 
tidak mengeluarkan pengumuman pada malam 
ini juga,     akan berakibat terjadinya     suatu 
pertumpahan darah dan pembunuhan besar-
besaran esok hari .” 

Mendengar kata-kata ancaman 
seperti itu, Soekarno naik darah dan 
berdiri menuju Wikana sambil berkata: “ 
Ini batang leherku, seretlah saya ke 
pojok itu dan potonglah leherku malam 
ini juga! Kamu tidak usah menunggu 
esok hari !”.       Hatta       kemudian 
memperingatkan W ikana; “... Jepang 
adalah masa silam. Kita sekarang harus 
menghadapi      Belanda yang akan 

berusaha untuk kembali menjadi tuan di negeri 
kita ini. Jika saudara tidak setuju dengan apa 
yang telah saya katakan, dan mengira bahwa 
saudara telah siap dan sanggup untuk 
memproklamasikan kemerdekaan, mengapa 
saudara tidak memproklamasikan kemerdekaan 
itu sendiri? Mengapa meminta Soekarno untuk 
melakukan hal itu ?”.
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Modul 7. Bekerja Dengan Header Dan Footer Dan Menyisipkan Simbol 

Dan Nomor Halaman 
 

Materi 
 

Membuat Header Dan 

Footer. 

Langkah Detailnya 
 

1. Buka file ”Gabung File”. Kemudian letakkan kursor di sebelah teks 

“TIPS MEMILIH……” (lihat gambar di bawah ini). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu “Page Layout” pilih icon menu Breaks pada ribbon, pada 

bagian Section Breaks, pilih Next Page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Kemudian letakkan kursor pada teks dengan nomor 3 (lihat gambar di 

bawah).
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4. Klik tab menu “Page Layout” pilih icon menu Breaks pada ribbon, 

Pada bagian Section Breaks, pilih Next Page. 

5. Klik tab menu Insert, sorot pada bagian ribbon Header & Footer. 

6. Klik tombol Header. 
 
 
 
 
 
 
 
 
 

7. Pilih Blank pada pilihan header yang muncul. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Ketikkan isi Header “WebMedia Trainning Centre”
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9. Klik icon menu Go to Footer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Ketikkan “Modul Latihan” dan buat rata kanan. Sekarang lihat pada 

halaman yang lain telah muncul header dan footernya 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Klik tombol Close header and footer pada ribbon untuk keluar dari 

header and footer. 
 
 
 
 
 

12. Tekan tombol Ctrl+S. 
 

Materi 
 

Menghapus 

Dan Footer. 

Langkah Detailnya 
 

Header 1. Double klik pada header atau footer (pada file ”Gabung File”). 

2. Klik tab menu Design. 

3. Klik icon menu Header pada ribbon. 

4. Pilih Remove Header pada menu yang muncul.
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5. Kemudian klik icon menu Go to footer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Klik icon menu Footer pada ribbon. 

7. Pilih Remove Footer pada menu yang muncul.
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8. Lihat perubahannya. Close dokumen Gabung File tanpa melakukan 

penyimpanan. 
 

Tip : Untuk lebih memahami anda bisa mengakses “www. 

videobelajar.com”. Anda     dapat     melihat     secara     visualisasi 

“Menyisipkan Footnotes, Endnotes, Citations, dan Bibliography”. 
 

Materi 
 

Menyisipkan Simbol. 

Langkah Detailnya 
 

1. Buka kembali file Tips Nama Cantik. 

2. Letakkan kursor di bawah judul, kemudian tekan Ctrl+E.
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3. Klik tab menu Insert , pilih tombol Symbol pada ribbon. 

4. Pilih More Symbol untuk mencari simbol yang lain. 
 
 
 
 
 
 
 
 
 
 
 
 

5. Pada kotak dialog yang muncul, pilih jenis Font : Wingdings, pilih jenis 

simbol (lihat contoh). Klik tombol Insert 3 kali. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Klik tombol Close. Lihat perubahan dalam dokumen. Simpan kembali 

dokumen anda. 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menyisipkan 

Halaman. 

Langkah Detailnya 
 

Nomor 1. Buka kembali file “Gabungan File”. 
2. Klik tab menu Insert > Page Number > Bottom of Page > Plain Number 

2.
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3. Perhatikan hasilnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Untuk menghapus halamannya, klik tab menu Insert > Page Number > 

Remove Page Numbers, perhatikan nomor halaman sekarang telah 

hilang.
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Tugas 
 

Tugas Modul 7. 

Petunjuk Pengerjaan Tugas 
 

Buatlah dokumen seperti di bawah ini. Setelah selesai coba anda simpan 

dengan nama ”Tugas Modul 7”.
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Newsletter 
Volume 1, Issue 1August 2008 

Continuing Articles across Pages 
Type your sub-heading here 

 

Your By-line 
Your Company Name 

 

This document was created using linked text boxes, which allow articles to flow continuously across 

pages. For example, this article continues on page two, while the one to the right continues on page 

three. When you add lines of words to a text box, the words in the following text box flows forward. 

When you delete lines of words from a text box, the words in the next text box moves backward. You 

can link several text boxes in an article, and you can have multiple articles in a document. The links 

do not have to occur in a forward direction. 

Inserting Linked Text Boxes 

To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your 

document where you want to insert the first text box, and insert additional text boxes where you want 

the text to flow. 

 

I N S I D E T H I S I S S U E 
 

1 Continuing Articles across Pages 

1 Instructions for Using this Template 

4 Inserting and Editing Pictures 

 
 
 
 

Instructions for Using This Template 
Type your sub-heading here 

 

Your By-line 
Your Company Name 

 

To keep these instructions, choose Print from the File menu. Press Enter to print the template. 

Replace the sample text with your own text to create your newsletter. 

Using Styles in This Template 

To change the Style of any paragraph, select the text by positioning your cursor anywhere in the 

paragraph. Select a Style from the drop-down Style list at the top-left of your screen. Press Enter to 

accept your choice.
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Modul 8. Menyisipkan Text Box, Word Art, Dan Clip Art 
 

Materi 
 

Menyisipkan Text Box 

Dalam Dokumen. 

Langkah Detailnya 
 

1. Letakkan kursor pada akhir paragraf ke 2 dokumen “Tips Nama 

Cantik”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Insert, klik icon menu Text Box pada daerah ribbon 

kelompok Text. 

3. Pilih Draw Text Box untuk membuat text box yang baru. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Klik tahan tarik, dan gambarkan (lihat contoh soal). 

5. Ketikkanlah isi text box sesuai contoh soal. Setelah selesai di ketik, 

pilih semua teks yang ada di text box, tekan tombol Ctrl+E.
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6. Untuk memformat text box, klik pada tepi text box, klik tab menu 

Format, kemudian pilih Text Box Style dan pilih jenis style (lihat style 

text box soal). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Klik icon menu Shadow Efect. Pilih salah satu jenis shadow yang ada, 

kemudian lihat perbedaannya.
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8. Sekarang klik icon menu 3-D Effect, kemudian pilih 3-D Style1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Untuk mengatur perataan text box terhadap teks dokumen, klik icon 

menu Text Wrapping, kemudian pilih Tight. Coba anda pilih jenis yang 

lain, dan lihat perubahannya pada dokumen kita.
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Tip : Untuk lebih memahami materi ini, anda dapat melihat video tutorial 

“Indah dengan Drop Caps, Text Box, dan Word Art” di website 

“www. videobelajar.com”. 
 

Materi 
 

Menyisipkan 

Art. 

Langkah Detailnya 
 

Word 1. Buka kembali file ”Gabung File”. 
2. Letakkan kursor di awal dokumen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Klik tab menu Insert, kemudian pilih icon Word Art pada ribbon 

kelompok text. Pilih Word Art Style 21.
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4. Ketikkan Isi Wort Art “Menggabungkan Beberapa Dokumen”, dan jenis 

(font) huruf : Arial Black, ukuran (size) : 36. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Klik tombol OK.
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6. Klik icon menu Spacing pada ribbon Text , kemudian klik Close. 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Klik pada tab ribbon Word Art Style, ganti style menjadi WordArt Style 

16. (coba anda klik style yang lain, lihat perbedaanya). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menyisipkan Clip Art. 

Langkah Detailnya 
 

1. Masih menggunakan “Gabung file”. Kemudian letakkan kursor pada 

akhir halaman pertama.
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2. Kemudian, klik tab menu Insert > Clip Art. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Kemudian klik tombol Go pada kotak dialog clip art. Perhatikan clip art 

yang muncul. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian klik gambar clip art “menara”. Perhatikan gambar sudah 

ditambahkan ke dalam dokumen.
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5. Klik icon menu Brightness (-20%), perhatikan perubahannya. Coba 

anda lakukan untuk icon menu adjusment picture yang lainnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Untuk format yang lainnya, lihat pada materi Text box. Setelah selesai 

simpan kembali dokumen anda. 
 

Tip : Untuk lebih memahami materi ini, anda dapat melihat video tutorial 

“Indah dengan Drop Caps, Text Box, dan Word Art” di website 

“www. videobelajar.com”.
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Tugas 
 

Tugas Modul 8. 

Petunjuk Pengerjaan Tugas 
 

Buat dokumen seperti di bawah ini. (logo, gambar boleh tidak sama).



𝐿 𝐿 
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Modul 9. Membuat Equation, Hyperlink, Watermark Dan Mencetak Dokumen. 
 

Materi 
 

Menyisipkan Objek 

Equation. 

Langkah Detailnya 
 

Ketikkanlah persamaan rumus di bawah ini. 𝑓  =  0 + 

∞ 

 𝑛 cos
𝑛𝜋 

+  𝑛 sin
𝑛𝜋 𝑛=1 

 

1. Buat dokumen baru (ctrl +N). Klik tab menu Insert , klik icon menu 

Equation , pilih Insert New Equation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Ketikkan f(x)= 

3. Kemudian klik icon menu Script kemudian pilih Subscript. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian klik di dalam kotak subscript.
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5. Ketikkan a , terus letakkan kursor di kotak bawahnya, ketikkan 0. 
 
 
 
 

6. Kemudian lakukan pengetikan untuk simbol yang lainnya.( langkah 

kerjanya sama, sesuaikan simbol dari pilihan yang ada dengan contoh 

latihan). 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Setelah selesai coba anda lihat/klik untuk simbol yang lainya. 

Perhatikan simbol – simbol yang ada. 

8. Close dokumen anda dan simpan dengan nama “Equation”. 
 

Materi 
 

Membuat dan 

Memanfaatkan 

Hyperlink. 

Langkah Detailnya 
 

1. Buka kembali file Daftar Isi 

2. Pilih teks “Daftar Isi”. 

 
 
 
 
 
 
 
 
 
 
 

3. Pilih tab menu Insert, kemudian pilih icon menu Hyperlik pada 

kelompok ribbon Link.
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4. Pada kotak dialog yang muncul, pilih folder Sample Pictur, kemudian 

pilih gambar Forest (pada windows Vista). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Klik tombol OK. 

6. Untuk menggunakan linknya, tekan Ctrl+klik pada teks Daftar Isi. Maka 

link akan membuka file linknya (forest.jpg).
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Materi 
 

Menggunakan 

Watermark. 

Langkah Detailnya 
 

1. Buka kembali file “Tugas Modul 1”. 
2. Klik tab menu Page Layout > Watermark > Custom Watermark. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Aktifkan pilihan Text watermark, isikan “INDONESIA SEHAT 2010” pada 

bagian Text. Pilih jenis huruf Arial Black, kemudian klik tombol OK.
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Materi 
 

Mencetak Dokumen 

Dengan Format 

Tertentu. 

Langkah Detailnya 
 

1. Buka kembali file Tip Nama Cantik. 

2. Klik Office button. 

3. Pilih Print (Ctrl +P). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, pilih jenis printer yang akan digunakan 

pada bagian printer Name.
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5. Klik All pada Page. 

6. Number of copies : 1. 

7. Print what : Dokument, Print : All pages in range. 

8. Pada bagian Zoom, Pages per sheet : 1 page. 

9. Scale to Paper size ; A4. 

10. Kemudian klik tombol OK. 
 

Tugas 
 

Tugas Modul 9. 

Petunjuk Pengerjaan Tugas 
 

Buatlah dokumen seperti di bawah ini, dengan menggunakan bantuan 

Equation dan tambahkan efek Watermark. Setelah selesai simpan 

dengan nama “Tugas Modul 9”.



  

− 
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Panduan Materi Matematika SMA (IPA). 

 

Latihan dan Pembahasan 
 
 

1. Suatu fungsi kuadrat mempunyai nilai minimum − 2 untuk x = 3 dan untuk 
x = 0 nilai fungsi itu 16. Fungsi kuadrat itu adalah .... 

a. f (x) = x
2 

+ 6x + 8 d. f (x) = 2x
2 −12x +16 

b. f (x) = x
2 − 6x + 8 e. f (x) = 2x

2 −12x −16 
c. f (x) = 2x

2 
+12x +16 

 

Pembahasan : 
Fungsi kuadrat dengan nilai minimum − 2 untuk x = 3 

adalah f (x) = α(x − 3)2 − 2 

f (0) = 16→ f (0) = α(0 − 3)2 − 2 = 16 

9α = 18 

Α = 2 ∴Fungsi kuadrat f (x) = 2(x − 3)2 − 2 
f (x) = 2x

2 −12x +16 

2. Nilai maksimum dari fungsi f (x) = −2x
2 

+ (k + 5)x +1− 2k adalah 5. 

Nilai k yang positif adalah… 

a. 1 c. 7 e. 9 

b. 5 d. 8 

Pembahasan : 

Nilai maksimum adalah  = 
−𝐷 

= − 
 
2−4  

 

f (x) = −2x
2 

+ (k + 5)x +1− 2k 
 
 

Nilai maksimum : y = − 
 

2−4  

4 

 

= 5 

 
 − 

𝑘 + 5 2 − 4 −2 1 − 2𝑘 

4 −2 

 

= 5 

 𝑘2 + 10𝑘 + 25 + 8 − 16𝑘 −8 

 

= 5 

 

K
2
-6k+33=40 

K
2
-6k-7=0 

(k+1)(k-7)=0 

K=-1 atau k=7 

 
 

Soal Latihan UN
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Modul 10. Membuat Dan Menghapus Tabel, Konversi Teks Ke Tabel Dan 

Tabel Ke Teks 
 

Buatlah Tabel Seperti di bawah ini : 
 

Rekapitulasi Perhitungan Rasio Likuiditas 

PT. Untung Terus 

Periode 2004 s/d 2006 

No Parameter 
 

1 Aktiva Lancar 

2 Hutang Lancar 

3 Kas 

4 Efek 
 

5 Piutang 
 

6 Jumlah Aktiva 

Tahun 2004 
 

705.181 

641.314 

6.178 

209.918 

674.637 

1.124.258 

Tahun 2005 
 

814.392 

732.048 

8.871 

266.308 

812.442 

1.339.067 

Tahun 2006 
 

859.047 

780.806 

9.999 

279.647 

855.881 

1.383.900 

 

Current Ratio 

Quick Ratio 

Cash Ratio 

W.C. to T.Asset Ratio 

1,10 1,11 1,13 

1,39 1,49 1,47 

0,34 0,38 0,37 

0,79 0,81 0,83 

 
 
 

Materi 
 

Membuat Tabel. 

Langkah Detailnya 
 

1. Buatlah dokumen baru (Ctrl+N). 

2. Kemudian klik tab menu Insert, kemudian pilih Table. 

3. Pada menu yang muncul klik Insert Table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 4. Isikan pada bagain Number of columns: 5 dan Number of rows: 11. 



Modul Aplikasi Komputer Microsoft office word 2007 

5. Klik tombol OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Kemudian ketikkan isi tabelnya (gunakan tanda panah pada keyboard 

untuk berpindah ke kanan–kiri atau atas–bawah cell). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menghapus Tabel. 

Langkah Detailnya 
 

1. Aktifkan/pilih tabel yang akan dihapus. 

2. Pilih tab menu Layout. 

3. Pada ribbon Row&Columns, pilih icon menu Delete. 

4. Pilih Table.
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5. Perhatikan, sekarang tabel telah hilang. Kemudian tekan tombol Ctrl+ 

Z, (batalkan penghapusan tabel). 

6. Kemudian simpan dengan nama Tabel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Mengkonversi 

Ke Teks. 

Langkah Detailnya 
 

Table 1. Buka kembali file “Tabel”. 
2. Letakkan kursor di dalam tabel.
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3. Klik tab menu Layout > Convert to Text 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, pilih Tab > OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Perhatikan, sekarang tabel kita sudah dikonversi menjadi teks biasa.
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Materi 
 

Mengkonversi 

Ke Tabel. 

Langkah Detailnya 
 

Teks 1. Pastikan dokumen/teks yang akan dikonversi menjadi tabel 

mempunyai perataan tab (gunakan file “Tabel” yang telah dikonversi 

menjadi teks). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Pilih semua teks yang akan dijadikan tabel.
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3. Klik tab menu Insert > Table > Convert Text to Table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Isikan Number of columns : 5, aktifkan pilihan Tabs, kemudian klik 

tombol OK.
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5. Perhatikan hasilnya. Sekarang teks kita sudah dikonversi menjadi 

tabel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tugas 
 

Tugas Modul 10. 

Petunjuk Pengerjaan Tugas 
 

Untuk lebih memahami materi pada modul yang telah kita pelajari, 

buatlah dokumen dengan tampilan seperti berikut, (gambar dan logo 

dapat anda sesuaikan dengan yang anda inginkan). 

Setelah selesai simpan dengan nama “Tugas Modul 10”.
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CREDIT MEMO 
 

[Your Company Name] 

[Your Company Slogan] 

 

[Street Address], [City, ST ZIP Code] 

Phone [000.000.0000] Fax [000.000.0000] 

[e-mail] 

 

CREDIT NO. [100] 

DATE: OCTOBER 28, 2008 

 

 

To 

 

[Name] 

[Company Name] 

[Street Address] 
[City, ST ZIP Code] 
[Phone] 

Customer ID [ABC12345] 

Job 

[Job Description] 

 
 
 

QUANITY ITEM # DESCRIPTION UNIT PRICE LINE TOTAL 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SUBTOTAL 

 
SALES TAX 

 
TOTAL
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Modul 11 Memanipulasi Tabel 
 

Materi 
 

Mengatur Border Dan 

Shading Tabel. 

Langkah Detailnya 
 

1. Seleksi Semua baris dari tabel. 

 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Design . 

3. Pada ribbon menu kelompok Table Style, pilih icon menu Borders. 

4. Pilih Border and Shadings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Aktifkan tab Border, pada bagian setting pilih Grid, Style pilih bentuk 

garis bingkai sesuai contoh pada latihan di atas. 

6. Color pilih Automatic. 

7. Width : 2¼. 

8. Apply to : Table 

 9. Klik OK. 
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10. Perhatikan hasil format tabelnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Untuk membuat shading atau warna background dari tabel, seleksi 

baris pertama tabel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Aktifkan kembali kotak dialog Border and Shadings (Lihat langkah 

sebelumnya). 

13. Pada kotak dialog yang muncul, pilih ading pada bagian Fill : Abu – 

abu.
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14. Tentukan jenis pola petterns dan warnanya pada bagian Petterns 

Style : 25%, Color : Merah, kemudian pada Apply to: Cell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

15. Setelah selesai klik tombol OK. Lihat hasilnya 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menyisipkan Baris 1. Letakkan kursor di cell baris ke 2 kolom pertama pada tabel. 

Dan Kolom Pada 

 Tabel.                                                                                                                                         
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2. Klik tab menu Layout 

3. Pada bagin ribbon Row&Columns pilih icon Insert below, lihat 

perubahan tabelnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Untuk menyisipkan kolom di sebelah kanan, klik pada cell baris ke 3 

kolom ke 2.
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5. Kemudian pada bagin ribbon Row&Columns klik icon menu Insert 

right. Perhatikan efek dari perintah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menghapus Baris Dan 

Tabel. 

Langkah Detailnya 
 

1. Letakkan kembali kursor pada kolom 1 baris 3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Layout. 

3. Pada ribbon kelompok Row&Columns pilih icon menu Delete.
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4. Pilih Delete Rows. Maka baris telah dihapus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Untuk menghapus kolom, letakkan kursor pada kolom ke tiga dari 

tabel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Klik tab menu Layout. 

7. Pada ribbon kelompok Row&Columns pilih icon menu Delete. 

 8. Pilih Delete Columns. 
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9. Perhatikan, kolom sekarang telah dihapus.



Modul Aplikasi Komputer Microsoft office word 2007 

 
 

Materi 
 

Mengatur Tinggi Baris 

Dan Lebar Kolom. 

Langkah Detailnya 
 

1. Pilih baris atau kolom yang akan diatur lebar atau tingginya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Layout. 

3. Pada ribbon kelompok Cell Size, isikan nilai pada bagian Table row 

height : 1 cm. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Untuk mengatur lebar kolom, seleksi kolom ke dua sampai dengan 

kolom ke lima.
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5. Klik tab Layout, pada ribbon Cell Size, isikan Table column width: 

3,5cm, lihat perubahannya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Menggabungkan Dan 

Memisahkan Baris 

Dan Kolom Tabel. 

Langkah Detailnya 
 

1. Pilih cell baris ke 8 kolom 1 dan 2.
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2. Pilih tab menu Layout, kemudian klik icon menu Merge Cell, lihat 

perubahannya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Coba anda gabungkan untuk tiga baris di bawahnya (lihat contoh 

soal). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Untuk memisahkan cell yang telah digabungkan, letakkan kursor di 

baris ke 8 kolom 1. 

5. Pilih tab menu Layout, klik icon menu Split cell. 
 
 
 
 
 
 
 
 
 
 

6. Pada kotak dialog yang muncul, isikan bagian Number of Rows : 1 dan 

 Number of columns : 2, kemudian klik tombol OK. 
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7. Kemudian tekan tombol Ctrl+Z, untuk membatalkan perintah Split cell. 

Kemudian simpan kembali dokumen kita (Ctrl + S). 
 

Tip : Untuk lebih memahami materi ini, anda dapat melihat video 

tutorial “Manipulasi Table” di website “www.videobelajar.com” 
 

Tugas 
 

Tugas Modul 11. 

Petunjuk Pengerjaan Tugas 
 

Buatlah desain dokumen form seperti di bawah ini (jenis huruf bebas). 

Setelah selesai simpan dengan nama “Tugas Modul 11”.

http://www.videobelajar.com/
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[Your Company Name] PURCHASE ORDER 

[YOUR COMPANY SLOGAN] 
 

[Street Address] 

[City, ST ZIP Code] 

Phone [(509) 555-0190] Fax [(509) 555-0191] 

 
 

P.O. NUMBER: [100] 

 

 

To: 

[Name] 

[Company Name] 

[Street Address] 

[City, ST ZIP Code] 

[Phone] 

Ship To: 

[Name] 

[Company Name] 

[Street Address] 

[City, ST ZIP Code] 

[Phone] 

 
 

P.O. DATE REQUISITIONER SHIPPED VIA F.O.B. POINT TERMS 

 
 
 
 

QTY UNIT DESCRIPTION UNIT PRICE TOTAL 

 
 
 
 
 
 
 
 
 
 
 
 

SUBTOTAL 
 

SALES TAX 
 

SHIPPING & HANDLING 
 

OTHER 
 

TOTAL 

 
1. Please send two copies of your invoice. 

 

2. Enter this order in accordance with the prices, terms, delivery 

method, and specifications listed above. 

3. Please notify us immediately if you are unable to ship as 

specified. 

4. Send all correspondence to: 

[Name] 

[Street Address] 

[City, ST ZIP Code] 

Phone [(509) 555-.0190] Fax [(509) 555-0191] 

 
Authorized by Date
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Modul 12. Menyisipkan Gambar, Shape Dalam Dokumen Dan Crop Image 
 

Materi 
 

Menyisipkan Gambar 

Ke Dalam Dokumen. 

Langkah Detailnya 
 

1. Coba anda buka kembali file ”Gabung File” pada latihan sebelumnya. 

2. Kemudian letakkan kursor pada halaman ke 2 di tengah paragraf ke 2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Klik tab menu Insert kemudian pilih icon menu Picture pada ribbon 

Illustrations. 
 
 
 
 
 
 
 
 

4. Pada kotak dialog yang muncul, carilah (Browsing) picture atau 

gambar “Toco Toucan”. Klik tombol Insert.
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5. Kemudian klik tab Format, klik icon menu Text Wrapping >Tight. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Sekarang coba anda perhatikan perubahannya.
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Materi 
 

Menyisipkan Shapes 

Dalam Dokumen. 

7. Kemudian coba anda lakukan untuk text wrapping yang lainnya. 

Langkah Detailnya 
 

1. Masih menggunakan dokumen “Gabung File”. 
2. Letakkan kursor di tengah paragraf ke-2, halaman ke-2 

 
 
 
 
 
 
 
 
 
 
 

2. Klik tab menu Insert, kemudian pada ribbon Illustrations pilih icon 

menu Shapes. 

3. Kemudian pilih shapes Smiley Face. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian klik and drag pada dokumen paragraf ke 2 sesuai dengan 

yang kita inginkan.
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5. Kemudian anda dapat memformat shapes yang ada pada bagian 

ribbon Shapes Style, Shadow Effect, 3-D Effects dan Arrange serta 

Size. (lihat pada materi menyisipkan Text box). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi 
 

Croping Image. 

Langkah Detailnya 
 

1. Buatlah dokumen baru (Ctrl+N). 

2. Klik tab menu Insert > Picture.
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3. Pilih gambar yang anda inginkan. Kemudian klik tombol Insert. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian pilih gambar yang akan dicrop/dipotong.
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5. Klik menu Format > Crop. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Klik drag pada sisi dimana gambar akan dipotong.
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7. Kemudian lepas. Lihat hasilnya, gambar sekarang sudah terpotong. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Kemudian tutup dokumen anda tanpa menyimpan (Ctrl+W). 
 

Materi 
 

Tugas Modul 12. 

Petunjuk Pengerjaan Tugas 
 

Memanfaatkan menu Insert Image, dan Shapes, buatlah dokumen 

seperti di bawah ini. Simpan dengan nama”Tugas Modul 12”.
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S o lu t i o ns Fo r 
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Ec onomy 
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Non-Profit Solutions P.3 

Trends & New Software P.4 

 
 

Sit amet, consec tetuer 
 

adipiscing elit, sed diam 
 

nonummy nibh euismod 

 

Exploring open source software opportunities. 
 

tincidunt ut laoreet dolore 

magna aliquam . Ut wisi 
ullamcorper. Et iusto odio 

 

enim ad minim veniam, 
 

quis nostrud exerci tation 

 

Volutpat mos at neque nulla lobortis 
 

dignissim conventio, torqueo, acsi roto modo. 
 

Feugait in obruo quae ingenium tristique elit vel 

ullamcorper. Et iusto odio                                                                                                              natu         meus.         Molior         torqueo         capio 

dignissim        qui        blandit                                                                                                              velit loquor aptent ut lorem erat feugiat pneum 

praeseptatum zzril delenit commodo vel obruo mara genitus. Suscipit, vicis 
 

augue duis dolore te praesent erat feugait epulae, validus indoles duis 

feugait nulla adipiscing elit,                                                                                                              
enim consequat genitus at. Sed, conventio, 

sed diam
 

nonummy nibh .                                                                                                                   
aliquip     accumsan adipiscing      augue       

blandit 

minim abbas oppeto commoveo. 
PERSONAL COMPUTING 

 

Tincidunt ut laoreet dolore 
 

magna aliquam erat volut 
 

pat. Ut wisi enim ad minim 
 

veniam, quis exerci tation 
 

ullamcorper     cipit     lobortis 
 

nisl ut aliquip ex 
 

it amet, consec tetuer 
 

adipiscing elit, sed diam 
 

nonummy nibh euismod 
 

tincidunt ut laoreet dolore 
 

magna aliquam . Ut 
 

wisi enim ad minim veniam, 
 

quis nostrud exerci tation 

 

Enim neo velit adsum odio, multo, in commoveo quibus 
 

premo tamen erat huic. Occuro uxor dolore, ut at 
 

praemitto opto si sudo, opes feugiat iriure validus. Sino 
 

lenis vulputate, valetudo ille abbas cogo saluto quod, 
 

esse illum, letatio conventio. Letalis nibh iustum 
 

transverbero bene, erat vulputate enim dolore modo. 
 

Loquor, vulputate meus indoles iaceo, ne secundum, 
 

dolus demoveo interdico proprius. In consequat os 
 

quae nulla magna. Delenit abdo esse quia, te huic. Ratis 
 

neque ymo, venio illum pala damnum pneum. Aptent 
 

nulla aliquip camur ut consequat



v  natu s. M li r 
l quor 
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torqueo capio velit 

 
aptent ut erat feugiat 
 

pneum     commodo vel 
 

obruo mara 
 

genitus. Suscipit, vicis 

 
 
 

tec hnol 
ogy 

c o n s u l t i n g 

 

praesent     erat     feugait 
 

epulae, validus indoles 
 

duis     enim     consequat 
 

genitus at lerpo ipsum. 
 

Enim neo velit adsum 
 

odio, 
 

multo, 
 

in commoveo quibus 
 

premo tamen erat 
 

huic. Occuro uxor 
 

dolore, ut at praemitto 
 

opto si     sudo,     opes 
 

feugiat     iriure     validus. 
 

Sino lenis vulputate, 
 

valetudo ille abbas cogo 
 

saluto quod, esse illum, 
 

letatio conventio. 

 
 
Letalis nibh iustum 
 

transverbero bene, erat 
 

vulputate enim dolore 
 

modo. Molior torqueo 
 

capio velit loquor 
 

aptent ut erat feugiat 
 

pneum     commodo     vel 
 

obruo mara genitus. 
 

Suscipit, vicis praesent 
 

erat feugait epulae, 
 

validus indoles duis 
 

enim consequat genitus 
 

at lerpo ipsum. Enim 
 

neo velit adsum 
 

odio, multo, 
 

in commoveo quibus 
 

premo tamen erat 
 

huic. Occuro 
 

uxor dolore, ut 
at praemitto 
opto si sudo.
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Modul 13. Membuat Diagram Dan Grafik 
 

Materi 
 

Menyisipkan Diagram 

Dalam Dokumen. 

Langkah Detailnya 
 

Buatlah gambar Diagram seperti di bawah ini : 
 

BAGAN ORGANISASI 

PT. XYZ 
 
 
 
 
 

Pimpinan 

 
 
 

Pimpinan 

Cabang 

Pimpinan 

Bidan g Operasional 

 
 
 

Penyelia 

Teller Pelayanan 
Nasabah 

 

Penyelia Unit 

Operasional 

Penyelia 

Pemasaran 
Bisnis 

 
 
 

1. Buatlah dokumen baru (Ctrl + N). 

2. Klik tab menu Insert kemudian pilih Smart art. 

3. Pada kotak dialog yang mucul, pilih Hierarchy, kemudian klik OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Kemudian klik pada shape level ke tiga, tekan tombol Delete pada 

keyboard.
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5. Perhatikan perubahannya. Kemudian klik shape level ke tiga kanan 

bawah (lihat gambar). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Klik tab menu Design, kemudian klik icon menu Add Shape , pilih Add 

Shape Before.
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7. Lakukan langkah yang sama untuk menambahkan shape yang sama 

(lihat contoh latihan). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Kemudian klik di dalam shape, dan mulailah ketikkan isi teksnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Simpan dokumen anda dengan nama “Organisasi”.
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Materi 
 

Membuat Diagram 

Grafik. 

Langkah Detailnya 
 

Buatlah grafik di bawan ini : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Buatlah Dokumen Baru (Ctrl + N) 

2. Klik tab menu Insert, kemudian klik icon menu Chart pada ribbon 

Illustrations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Pada kotak dialog Insert Chart, pilih Column > Clustered Cylinder, 

kemudian klik tombol OK.
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4. Pada kotak dialog yang mucul, pada bagian Windows Excel, 

ketikkanlah data di bawah ini : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Setelah selesai klik Close untuk Windows Excelnya, kemudian 

perhatikan grafiknya.
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6. Untuk membuat judul grafiknya, aktifkan grafik yang telah kita buat, 

kemudian klik tab menu Layout > Chart Title > Above Chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Kemudian pada kotak dialog yang muncul, ketikkan judul grafiknya 

“Grafik Penjualan HandphoneToko Sinar Seluler “ .
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8. Klik pada icon menu Axis Title, pilih Primary Horizontal Axis Title, 

kemudian pilih Title Below Axis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Pada kotak dialog yang muncul, ketikkan judul axisnya “Merek 

Handphone”.
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10. Kemudian klik icon menu Axis Title > Primary Vertical Axis Title > 

Rotated Title. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Ketikkan judul Axisnya “Unit Penjualan”.
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12. Kemudian klik icon menu Data Labels > Show, perhatikan 

perubahannya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Setelah selesai simpan dengan nama ”Grafik Penjualan 2008”. 
 
 

Tip : Untuk lebih memahami materi ini, anda dapat melihat video 

tutorial “Baru : Smart Art, Shapes, dan Multimedia” di website 

“www. videobelajar.com”.
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Tugas 
 

Tugas Modul 13. 

Petunjuk Pengerjaan Tugas 
 

Buatlah dokumen di bawah ini dengan menggunakan fasilitas Chart. 

Setelah selesai simpanlah dengan nama “Tugas Modul 13”. 
 
 

Pertumbuhan Produk Domestik Regional Bruto 
 

Selama 5 tahun terakhir Pertumbuhan ekonomi “Medan Baru” memperlihatkan 

perkembangan yang semakin membaik kecuali pada tahun 2004 pertumbuhan sebesar 5,30 

persen masih Iebih randah dari tahun sebelumnya yang telah mencupai 5,32 persen, Hal ini 

seirinng dengan lambatnya pertumbuhan investasi sebesar 3,26 persen padia tahun 2004 

dibandingkan pertumbuhan investasi tahun 2003 sebesar 5,48 persen 
 

PERKEMBANGAN PRODUK REGIONAL DOMESTIK BRUTO PROPIINSI 

“MEDAN BARU” TAHUN 2002 - 2004 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pen dorong pcrtumbuhan ekonomi “Medan Baru” secara umum bertumpuh pa da 

sektor erutama dipengaruhi olsewh asntaai,knya konsumsi masyarakat serta adanya d              t 

ukunganaan perbankan terutama kredit komsumsi yang relatif besar & perke pembiay 

mbanganuhpaenrtuemkobnomi “Medan Baru” dapat dilihat pada gambar I di bawah ini: 
 

GRAFIK PERTUMBUHAN EKONOMI 

MEDAN BARU TAHUN 2000 - 2004 
 

100000000 

90000000 

80000000 

70000000 

60000000 

50000000 

40000000 

30000000 

20000000 

10000000 

0 

2000 2001 2002 2003 2004 

 
 
 
 
 
 

(persen) Harg 

berlaku Harga 

Konstan



Modul Aplikasi Komputer Microsoft office word 2007 

Modul 14. Membuat Dan Mencetak Mail Merge 
 

Materi Langkah Detailnya 
 

Membuat Mail Merge. 1. Sebelum membuat Mail Merge, kita harus membuat dokumen 

Induk/dokumen utama. Buatlah dokumen induk di bawah ini : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Setelah dokumen induk selesai simpan dengan nama “Formulir”. 

Kemudian klik tab menu Mailings. 

3. Pada bagian ribbon kelompok Start Mail Merge klik icon menu Start 

Mail Merge. 

4. Kemudian pilih Step by Step Mail Merge Wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Pada kotak dialog yang muncul, pilih Letters pada bagian Select 

document type. Kemudian klik Next : Starting document.
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6. Pada step yang selanjutnya, pilih Use the current document, klik Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Pada Step yang ketiga ini kita akan membuat sumber data (data 

source) untuk mail merge. Sumber data kita adalah sebagai berikut :
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Nama Tgl. Lahir 

 
Andi 22-10-1982 

 
Wati 25-6-1984 

 
Herni 1-1-1981 

 
Susi 8-9-1985 

 
Alamat 

 
Jl. Setia Budi No. 11 Medan 

 
Jl. Sei Padang No. 3 Medan 

 
Jl. Djamin Ginting No. 18 

Medan 

Jl. Aksara No. 12 Medan 

 
No. Hp 

 
0812334455 

 
0813708897 

 
08116800001 

 
0815457789 

 

Palatihan 

Yang Diikuti 
 

Web Master 

 
Design 

Fundamental 

Cisco 

 

Web Master 

Uang 

Pendaftara 

n 

150.000 
 

150.000 

 
250.000 

 
150.000 

 

Uang 

Kursus 

 
1.500.000 

 
1.500.000 

 
3.000.000 

 
1.500.000 

 
 

Pilih Type a new list kemudian klik teks Create. Kemudian klik Next : 

Write your letter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Pada kotak dialog yang muncul, judul dari kolom tidak sesuai dengan 

dokumen induk kita. Klik tombol Customize Columns, kemudian pilih 

Field Name yang akan diganti, klik tombol Rename.
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9. Ketikkan Nama pada Change field name. Setelah selesai klik tombol 

OK. Lakukan hal yang sama untuk field yang lain. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Untuk menghapus field yang tidak digunakan, pilih field yang akan 

dihapus, klik tombol Delete, kemudian klik Yes. Lakukan untuk 

menghapus field yang lain.



 Modul Aplikasi Komputer Microsoft office word 2007  

11. Kemudian klik tombol OK, dan mulailah mengisikan datanya. Untuk 

menambah data yang baru klik tombol New Entry. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Setelah semua data diinput, klik tombol OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Kemudian tentukan tempat penyimpanan, dan ketikkan nama data 

 sourcenya adalah 123. Kemudian klik tombol Save. 
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14. Kemudian klik Next : Write your letter. Pada kotak dialog yang 

muncul, letakkan kursor di sebelah field nama, kemudian klik More 

Item, Pilih field Nama, kemudian klik Insert. Lakukan untuk 

memasukkan field yang lainnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

15. Klik tombol Next : Write your letter.
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16. Pada step yang ke 5 ini anda dapat melihat masing–masing isi 

datanya dengan mengklik Preview your letter. Kemudian klik Write 

your letter.
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Materi 
 

Mengedit Data Source 

Mail Merge. 

Langkah Detailnya 
 

1. Klik icon menu Edit Recepient List. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Kemudian pada kotak dialog yang muncul, klik data sourcenya, 

kemudian klik Edit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Kemudian klik, Heru ganti menjadi Heri.
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4. Kemudian klik tombol New Entry, ketikkanlah data di bawah ini : 
 
 
 
 

 
Nama Tgl. Lahir 

 
Lady 20-10-1982 

 
Rama 5-6-1984 

 
Alamat 

 
Jl. Setia Budi No. 50 Medan 

 
Jl. Sei Padang No. 59 Medan 

 
No. Hp 

 
0812337788 

 
0813708845 

 

Palatihan 

Yang Diikuti 
 

Web Master 

 
Design 

Fundamental 

Uang 

Pendaftara 

n 

150.000 

 

150.000 

Uang 

Kursus 

 
1.500.000 

 
1.500.000 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Kemudian jika telah selesai klik tombol OK, lihat perubahan datanya. 

5. Kemudian klik OK kembali.
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Materi 
 

Mencari 

Source. 

Langkah Detailnya 
 

Entry Data 1. Klik icon menu Edit Recepient. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Pada kotak dialog yang muncul, klik Find recipient.
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3. Isikan pada Find : Heri (untuk mencari nama Heri), Kemudian klik 

tombol Next. Lihat efek dari perintah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Coba anda cari untuk entri data yang lain. 

5. Setelah selesai klik tombol OK 
 

Materi 
 

Mencetak Mail Merge. 

Langkah Detailnya 
 

1. Pada step yang ke 6 ini, klik icon Print untuk mencetak mail merge 

yang kita buat atau Edit individual letters untuk melihat hasil mail 

merge secara mendetail. Klik icon Print
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2. Pada kotak dialog yang muncul, pilih All untuk mencetak semua data 

mail merge kita. Klik OK. 
 
 
 
 
 
 
 
 
 

3. Kemudian atur setingan printer pada kotak dialog Print.( Lihat materi 

mencetak dokumen). Klik tombol OK.
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Tugas 
 

Tugas Modul 14. 

Petunjuk Pengerjaan Tugas 
 

Buatlah surat di bawah ini dengan menggunakan Mail Merge dengan 

source data yang telah ada. Setelah selesai simpan dengan nama “Tugas 

Modul 14”. 
 

Your 

Name 

Jacklyn 

 
Joko 

 

Address City 
 

Jl. Asia 11 Medan 

 
Jl. Barat Medan 

Daya 13 

ST ZIP 

Code 

20131 

 
20135 

 

Recipient Name 
 

Maria Angelin 

 
Merlyn 

 

Title Company Name 
 

Mrs. PT. CBA 

 
Ms. PT. Galang Jaya 

Street 

Address 

Jl. Pulo 

Gadung 12 

Jl. Pinang 

124 

 
 

[Your Name] 

[Address] 

[City, ST ZIP Code] 

August 7, 2008 
 
 

[Recipient Name] 

[Title] 

[Company Name] 

[Street Address] 
 
 

Dear [Recipient Name]: 
 

We are all aware of the toll that addiction can take on our community. The halfway house is a 

project organized to tackle the problem head-on. 
 

With the help of city service agencies and law enforcement agencies and the cooperation of the 

judicial system, certain teenagers are offered a one-time opportunity to participate in this 

program. These young men and women are given intensive counseling, job training, and other 

skill enhancements needed to become productive citizens. Approximately 85 teenagers each year 

graduate from this two-year intensive program. 
 

This year we have expanded our operations, and we need your help. We are inviting you to join 

our executive board of directors. The board consists of business professionals such as you, who can 

assist us in directing, organizing, and implementing the large fundraising campaign that we must 

undertake soon. The executive board meets the first Tuesday of each month, and select 

committees meet an additional one or two times a month. 
 

Please join us. The halfway house and the teenagers who live there need you. 
 

Sincerely, 
 
 
 
 

[Your Name] 
 

Copyright ©1998 by junaja82@yahoo.co.id

mailto:junaja82@yahoo.co.id
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Modul 15. Membuat Label Amplop Mail Merge 
 

Materi 
 

Membuat Label 

Amplop Menggunakan 

Mail Merge. 

Langkah Detailnya 
 

1. Buat dokumen baru (Ctrl + N). 

2. Klik tab menu Mailings > Start Mail Merge > Envelopes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Pada Envelope size pilih Size 6 ¾ (3 5/8 x 6 ½ in). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Klik tab Printing Option, pada kotak dialog yang mucul aktifkan pilihan 

Face up kemudian pilih metode perataan printnya vertical corner. 

Setelah selesai klik OK.
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5. Klik icon menu Select Recipients > Type New list. 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Kemudian ketikkan datanya sebagai berikut : 

Nama Alamat 

Rizal Jl. Aksara No.4 Medan 

Nurdin Jl. Pancing No. 98 Medan 

Rini Jl. Skip No. 34 Medan 

Rina Jl. Skip No. 32 Medan 

Kode Pos 

20131 

20132 

13120 

13120 

No. HP 

0815889745 

0811896697 

06177896 

0819856678 

 

7. Klik tombol Costumize Columns.
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8. Klik Title > Rename pada kotak dialog Rename Field ketikkan Nama, 

kemudian klik OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Lakukan untuk menyesuaikan nama field yang lainnya (lihat pada 

materi mail merge sebelumnya), sehingga tampilannya menjadi 

sebagai berikut :
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10. Kemudian pada Field names klik Address Line 1 kemudian klik 

tombol Delete kemudian klik tombol Yes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Lakukan untuk field yang lainnya yang tidak diperlukan (Lihat materi 

penghapusan field sebelumnya), sehingga tampilannya sebagai 

berikut :
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12. Kemudian klik tombol OK, kemudian ketikkanlah data diatas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Untuk menambahkan data yang lainnya, klik tombol New Entry dan 

ketikkanlah data yang lainnya (lihat materi sebelumnya), sehingga 

tampilannya sebagai berikut :
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Kemudian klik tombol OK. 

14. Kemudian simpan data sourcenya pada folder Document, File name : 

Amplope, klik tombol Save. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

15. Kemudian tambahkan teks “Pengirim” pada ujung kiri atas amplop, 

kemudian Enter sekali.
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16. Klik icon menu Insert Merge Field, pilih Nama. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

17. Tekan Enter, kemudian ulangi langkah di atas untuk memasukkan 

field yang lainnya, sehingga tampilannya seperti di bawah ini.
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18. Kemudian klik icon menu Finish& Merge > Edit Individual Document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

19. Pada kotak dialog yang muncul, pilih All . Perhatikan hasilnya.
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Materi 
 

Mencetak Label 

Amplop Mail Merge. 

Langkah Detailnya 
 

1. Jika anda ingin mencetak amplop anda, klik icon menu Finish&Merge. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Pada kotak dialog print yang muncul, pada Printer Name, pilih printer 

yang akan anda gunakan (sesuai printer anda masing-masing). 

3. Pada bagian Page Range pilih All. 

4. Pada bagian Copies, isikan Number of Copies : 1 

5. Klik tombol OK untuk mencetak amplop kita.
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Tip : Untuk lebih memahami materi ini, anda dapat melihat video 

tutorial “Surat Berantai dengan Mail Merge” di website 

“www.videobelajar.com”. 
 

Tugas 
 

Tugas Modul 15. 

Petunjuk Pengerjaan Tugas 
 

Buatlah label envelope dengan ukuran M65 (155 x233 mm), dengan 

menggunakan Mail Merge. Setelah selesai simpan dengan nama “Tugas 

Modul 15”.

http://www.videobelajar.com/
http://www.videobelajar.com/
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Data Source : 

Pengirim 

Nama Alamat Kota 

Hasan Jl. Suaka ramai          Medan 

Dedi Jl. Sei mencirim         Batam 

Ruri Jl. Paya Bakung         Medan 

Hp 

0319565698 

0852467897 

0852889789 

E-Mail T 

Oke@yahoo.com 

leo@gogmail.com 

sur_adie@yahoo.com 

Tanggal 

11/8/07 

5/8/07 

11/5/07 

 

Penerima 

Jabatan 

Maneger 

Direktur 

HRD. SDM 

 

Perusahaan 

PT. Indah Sakti 

PT. Telpam 

PT. Skuat Ind. 

 

Alamat 

Jl. Beruang 18 

Jl. Seraya 21 

Jl. Serayu 69 

 

Kota 

Medan 

Bandung 

Jakarta 

 

Kode Pos 

20151 

60151 

30120

mailto:Oke@yahoo.com
mailto:leo@gogmail.com
mailto:sur_adie@yahoo.com


MODUL 3: 

MICROSOFT EXCEL 2007 
 

Microsoft Excel, untuk selanjutnya disingkat Excel, adalah program aplikasi yang banyak 

digunakan untuk membantu menghitung, memproyeksikan, menganalisa, dan mempresentasikan data. 

Disini kita akan banyak bersinggungan dengan metode2 pembuatan tabel dan grafik yang sangat 

dibutuhkan sekali dalam penyusunan data2 perusahaan, hasil2 penelitian, maupun dalam pembuatan 

makalah pribadi. 
 
BEKERJA DENGAN MICROSOFT EXCEL 

A. Lembar Kerja Microsoft Excel 
 

Sebelum mulai memasuki pembahasan Microsoft Excel, ada baiknya kita mengenal lebih dulu 

bagaimana tampilan Microsoft Excel itu, beserta beberapa istilah2 umum yang akan digunakan. Beberapa 

istilah2 umum yang diberikan pada gambar dibawah ini akan banyak digunakan dalam pembahasan 

selanjutnya, sehingga akan lebih baik bila kita menghafalkannya dengan baik. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 1. Tampilan Microsoft Excel dan beberapa istilah penting 
 
B. Memindahkan Penunjuk Sel (Cell Pointer) 
 

Ada beberapa cara untuk memindahkan cell pointer. Untuk lengkapnya silahkan lihat table 

dibawah.



 

Tabel 1. Beberapa Cara Memindahkan Cell Pointer 
 

Tombol 
 
 

Enter 

Home 

Ctrl + Home 

Ctrl + End 

PgUp 

PgDn 

Alt + PgUp 

Alt + PgDn 

Ctrl + PgUp 

Ctrl + PgDn 

Keterangan 

Pindah satu sel ke kiri, kanan, atas atau bawah 
 
Pindah satu sel ke bawah 

Pindah ke kolom A pada posisi baris yang aktif 

Pindah ke sel A1 pada lembar kerja yang aktif 

Pindah ke posisi sel terakhir yang sedang digunakan 

Pindah satu layer ke atas 

Pindah satu layer ke bawah 

Pindah satu layer ke kiri 

Pindah satu layer ke kanan 

Pindah dari satu tab lembar kerja ke tab lembar kerja berikutnya 

Pindah dari satu tab lembar kerja ke tab lembar kerja sebelumnya 

 
 

C. Memasukkan Data ke Lembar Kerja 
 

Berbagai jenis data dapat dimasukkan ke dalam lembar kerja seperti teks, nilai, tanggal, jam dan 

lain sebagainya. Untuk memasukkan data ke dalam suatu sel, dapat mengikuti langkah berikut ini : 

1. Pilih atau klik sel tempat anda akan memasukkan data 

2. Ketikkan data yang ingin dimasukkan 

3. Tekan Enter atau tombol arah panah atau tombol PgUp dan PgDn 
 
 

D. Memperbaiki Kesalahan Pengetikan 
 

Bila ada kesalahan pengetikan data, anda dapat memperbaikinya dengan mengikuti langkah-

langkah berikut ini : 

1. Pilih sel yang datanya ingin diperbaiki, lalu tekan F2. Atau klik tombol kiri maouse 2 kali pada sel 

yang datanya ingin diperbaiki. 

2. Selanjutnya perbaiki data yang salah tersebut dan tekan tombol Enter bila sudah selesai. 
 
 

E. Menggunakan Rumus 
 

Anda dapat memasukkan rumus yang berupa instruksi matematika ke dalam suatu sel pada lembar 

kerja. Operator hitung yang dapat digunakan diantaranya adalah + (penjumlahan), －(pengurangan), * 

(perkalian), dan ^ (perpangkatan). 

Untuk mengenali cara penggunaannya, terlebih dahulu marilah membuat table seperti gambar 2 

dibawah ini.



 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2. Tabel Upah Kerja 
 
 

Untuk mengisi sel E5 yakni Total Upah yang Diterima, dapat ditempuh dengan beberapa cara. 

1. Menulis Rumus dengan Menggunakan Angka Tetap 

a. Tempatkan penunjuk sel pada posisi yang diinginkan (dalam contoh ini E5) 

b. Ketik rumus “=48*3500” pada kolom baris rumus dan tekan Enter. 

Catatan : Penulisan rumus selalu diawali dengan lambng sama dengan (=). 
 
2. Menulis Rumus dengan Referensi Sel 

a. Tempatkan penunjuk sel pada posisi yang diinginkan (dalam contoh ini E5) 

b. Ketik rumus “=E3*E4” pada kolom baris rumus dan tekan Enter. 

Catatan : Dengan menggunakan cara ini, bila data di sel E3 &(atau) E4 diubah, maka hasil di sel E5 

pun akan ikut berubah. 
 
3. Menulis Rumus dengan Cara Menunjuk 

Dengan menggunakan keyboard atau mouse : 

a. Tempatkan penunjuk sel pada posisi yang diinginkan (dalam contoh ini E5) 

b. Ketik “=” pada kolom baris rumus 

c. Pilih atau klik sel E3, lalu ketik “*” 

d. Pilih atau klik sel E4 lalu tekan Enter. 
 
 

F. Membuat Range/Blok Sel 
 

Pada saat bekerja menggunakan Excel, kita tidak hanya bekerja dalam satu sel saja. Terkadang, 

anda akan bekerja dalam grup/kumpulan sel. Misalnya saja bila anda ingin merubah jenis huruf beberapa 
kolom dan (atau) baris, ingin merubah rumus beberapa kolom dan (atau baris), copy-paste atau mendelete 

data beberapa kolom dan(atau) baris, dll. Dalam kondisi2 seperti ini, anda dapat menggunakan range/blok 

sel ini untuk memudahkan kerja anda. 

Range dinamakan menurut alamat sel di ujung kiri atas sampai ujung kanan bawah. Sebagai 

contoh, range dari sel B2 sampai E7 dituliskan sebagai range B2:E7. (lihat Gambar 3).



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar3. Tampilan Range B2:E7 
 
 

Range/blok sel dapat dibuat dengan beberapa cara : 

1. Membuat Range Menggunakan Tombol Shift 

a. Tempatkan penunjuk sel awal range/bagian awal sel yang ingin diblok, yaitu B2 (lihat Gambar 3). 

b. Sambil menekan Shift, tekan tombol anak panah sampai sel tujuan, yaitu E7 
 
2. Membuat Range Menggunakan Mouse** 

a. Klik sel yang merupakan sel awal range, yaitu B2. Pointer/penunjuk mouse harus barada dalam 

keadaan tanda plus warna putih (tunjuk ke dalam sel, bukan tepi sel). (lihat Gambar 3). 

b. Sambil tetap menekan klik kiri mouse, gerakkan mouse (drag) ke sel tujuan, yaitu sel E7. 
 
3. Membuat Kolom atau Baris 

Suatu kolom atau baris dapat disorot dengan mengklik huruf kolom atau nomor baris yang anda 

inginkan. Misalnya cukup klik huruf kolom B bilai ingin menyorot seluruh kolom B. 
 
4. Menyorot Sederetan Kolom atau Baris 

Untuk menyorot sederetan kolom (misalnya B, C, D) atau sederetan baris (misalnya 3, 4, 5) dapat 

dilakukan dengan mengikuti langkah berikut ini : 

a. Klik di huruf kolom atau di nomor baris awal (di contoh ini adalah B atau 3) 

b. Sambil tetap menekan tombol mouse kiri, geserlah(drag) pointer(penunjuk) mouse hingga 

menyorot seluruh baris itu (di contoh ini adalah D atau 5). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar4. Menyorot Sederetan Kolom



 

G. Menghapus Data 
 

Untuk menghapus data di suatu sel atau range tertentu, pindahkan sel ke, atau buatlah range tempat 

yang ingin dihapus, lalu tekan tombol Delete. Dan bila ingin menghapus format tampilan data/sel dapat 
dilakukan dengan memilih dan mengklik menu Edit, Clear, Formats. 
 
H. Memasukkan Rangkaian Data dengan Fasilitas AutoFill 
 

Untuk memasukkan data berupa angka atau teks dengan fasilitas AutoFill, dapat dilakukan dengan 
mengikuti langkah2 berikut ini : 

1. Pilih/klik sel tempat posisi awal dari rangkaian data yang ingin anda buat. Misalnya pilih/klik sel B2. 

2. Ketik data awal yang anda inginkan. Misalnya teks “Jan” (January) 

3. Pada sel berikutnya (sel dibawah/B3 atau disampingnya/C2) ketik data berikutnya yang anda 

inginkan. Misalnya di B3 ketik “Feb” (February) 

4. Sorot/bloklah B2:B3. (Lihat Gambar5) 
 
 
 
 
 
 
 
 

Gambar 5. Tampilan Data Awa 
 
5. Dalam keadaan masih tersorot, arahkan penunjuk/pointer mouse ke pojok kanan bawah sel B3 hingga 

tanda plus putih berubah menjadi plus hitam 

6. Tekanlah tombol kiri mouse dan geser/drag posisi pointer mouse ke sel yang diinginkan misalnya 

B12. Dengan ini rangkaian data angka dapat ditampilkan. Lihat Gambar 6. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 6. Hasil Rangkaian Data dengan Teknik AutoFill



 

I. Menggunakan Fasilitas AutoCalculate dan AutoSum 
 
1. AutoCalculate 

Fasilitas AutoCalculate (penghitungan otomatis) digunakan untuk melakukan penghitungan dengan 
cepat dan mudah dari data2 yang cukup banyak dalam suatu range tertentu. Didalam fasilitas 

AutoCalculate ini terdapat 6 buah perintah, yakni perintah otomatis untuk menghitung rata2 

(Average), jumlah data (Count), banyak data angka (Count Nums), nilai max (Max), nilai min (Min), 

dan jumlah data angka (Sum). 
 

Cara menggunakannya adalah sebagai berikut : 

1. Sorot range data yang akan dikalkulasi/hitung. Misal sorot range C7:C12 dari data seperti 

dibawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar7. Contoh Penggunaan AutoCalculate 
 

2. Klik tombol kanan mouse di baris status, dan pilihlah jenis kalkulasi yang anda inginkan. 

Misalkan pilihlah Average(A) untuk menghitung rata2 data. 

3. Hasilnya akan ditampilkan di baris status. 
 
2. AutoSum 

Fungsi AutoCalculate diatas adalah untuk menghitung cepat data2 yang cukup banyak, tetapi tidak 

dapat menuliskan secara otomatis di lembar kerja anda. Khusus untuk penjumlahan (Sum), ada cara 

mudah lain untuk melakukannya yang sekaligus juga dapat langsung menuliskannya ke lembar kerja 

anda. Caranya adalah dengan menggunakan tombol toolbar AutoSum (Σ). 
 

Misalnya dalam contoh diatas, bila kita ingin menuliskan total unit, letakkan pointer mouse ke tempat 

yang kita inginkan (misalnya C13), lalu tekan tombol Σ di toolbar. Selanjutnya sorot range yang ingin 

dijumlahkan (dalam contoh ini adalah C5:C10) dan tekan Enter.



 
 
 
 
 
 
 
 
 
 

AutoSum 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 8. Contoh Penggunaan AutoSum 
 
 
 
 

LATIHAN SOAL 
 

Buatlah lembar kerja daftar penjualan ponsel dari PT. SEJAHTERA menjadi seperti bentuk dibawah ini. 

Serta isi pulalah tempat kosong pada kolom dan baris JUMLAH. 
 
Ketentuan Soal : 

 Buat rangkaian nama bulan dengan menggunakan fasilitas AutoFill 

 Hitung jumlah penjualan mobil setiap bulannya dan untuk setiap merk 

 Simpanlah lembar kerja pada komputer dengan menggunakan nama file Latihan.XLS.



 

J. Mengatur Lebar Kolom 
 
1. Mengatur Lebar Kolom Menggunakan Mouse 

1. Arahkan pointer mouse pada batas kanan kolom yang akan diubah hingga tanda plus warna putih 

berubah menjadi tanda panah dua arah. 

Catatan : Bila ingin mengubah lebar sederet kolom, terlebih dahulu bloklah kolom yang akan 

diubah lebarnya, kemudian tempatkan pointer mouse ke batas kanan salah satu kolom tersebut. 

2. Klik tombol kiri mouse, dan sambil terus menekan mouse geser(drag)-lah mouse hingga lebar 

kolom sesuai yang diinginkan. 
 
2. Mengatur Lebar Kolom Sesuai Data Terpanjang 

1. Arahkan pointer mouse pada batas kanan huruf kolom yang akan diubah lebarnya. 

2. Klik dua kali pada batas kolom. Lebar kolom akan mengikuti data terpanjang yang ada pada 

kolom seperti terlihat pada gambar9. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 9. Mengubah Lebar Kolom Sesuai Data Terpanjang 
 
 

K. Mengatur Tinggi Baris 
 
1. Arahkan pointer mouse pada batas bawah baris yang akan diubah hingga tanda plus warna putih 

berubah menjadi tanda panah dua arah. 

Catatan : Bila ingin mengubah tinggi sederet baris, terlebih dahulu bloklah baris yang akan diubah 

tingginya, kemudian tempatkan pointer mouse ke batas bawah salah satu baris tersebut. 

2. Klik tombol kiri mouse, dan sambil terus menekan mouse, geser(drag)-lah mouse hingga tinggi baris 

sesuai yang diinginkan. 
 
 

L. Mengatur Format Tampilan Huruf 
 

Data yang ketikkan pada lembar kerja dapat ditampilkan dengan berbagai bentuk untuk 

memudahkan dan membuat variasi dalam lembar kerja anda. Bentuk huruf (font), ukuran huruf (size), 
garis bawah (underline), warna huruf (color) dan efek khusus lainnya dapat anda tambahkan dalam 

data anda. 

Dua cara dalam melakukan format huruf dapat ditempuh melalui perintah yang ada di baris 

menu dan toolbar.



 

1. Format Melalui Perintah di Baris Menu 

a. Sorot sel atau range yang akan anda format 

b. Pilih dan klik menu Format(O), Cells (CTRL+1), dan kotak dialog Format Cells akan ditampilkan 

c. Pada kotak dialog Format Cells tersebut, klik tab Font. 

d. Tambahkanlah efek khusus yang diinginkan pada teks dan klik OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 10. Kotak Dialog Format Cells – Tab Font 
 
 
2. Format Melalui Toolbar 
 

Tabel 2. Jenis-jenis Perintah Toolbar untuk Melakukan Format Tampilan Huruf 
 

Toolbar 
 
 
 

/ 

Jenis Perintah 

Text Font 

Font Size 
 

Bold 

Keterangan Fungsi 

Memilih bentuk huruf (font) 

Mengubah ukuran huruf (size) 
 
Menampilkan huruf tebal (bold) 

 

Italic 
 

Underline 
 

Font Color 

Menampilkan huruf miring (italic) 
 

Memberi garis bawah (underline) 
 

Memilih warna huruf (font color)



 

M. Meratakan Tampilan Data 
 

Bila diperlukan, anda dapat mengatur tampilan data yang tersimpan pada suatu sel atau range 

tertentu agar posisinya ditampilkan rata kanan, kiri, di tengah sel atau di tengah beberapa kolom tertentu. 

Ada 2 cara yang dapat ditempuh dalam melakukan perataan tampilan data ini, yakni dengan 

menggunakan perintah yang ada di baris menu dan toolbar. 
 
1. Meratakan Data dengan Peintah di Baris Menu 

a. Sorotlah sel atau range yang akan anda ubah tampilan datanya 

b. Pilih dan klik menu Format(O), Cells (CTRL+1) dan kotak dialog Format Cells akan ditampilkan 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 11. Kotak Dialog Format Cells – Tab Alignment 
 
 

c. Pada kotak dialog tersebut, klik tab Alignment 

d. Lakukan pemilihan sesuai keinginan anda pada kotak : 

• Vertical : digunakan untuk memilih perataan secara vertical. Pilihan yang dapat dilakukan 

adalah Top (rata atas), Center (rata tengah), Bottom (rata bawah), Justify (seluruh data 

ditampilkan pada sel secara penuh).



 

• Horizontal : beberapa pilihan yang dapat dilakukan adalah : 

General Huruf ditampilkan rata kiri dan angka rata kanan 

Left (Indent) 

Center 

Right 

Fill 

Justify 

Center Across Selection 

Data ditampilkan rata kiri 

Data ditampilkan rata tengah 

Data ditampilkan rata kanan 

Mengisi seluruh sel dengan mengulang data 

Data ditampilkan pada sel secara penuh 

Data ditampilkan di tengah2 beberapa kolom 

• Orientation : untuk mengatur orientasi data dan derajat kemiringannya. 
 

e. Klik OK 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 12. Contoh Tampilan Data Secara Horizontal 
 
 
 
 
 
 
 
 
 
 
 

Gambar 13. Contoh Tampilan Perataan Data dengan Kemiringannya 
 
 
2. Meratakan Data dengan Perintah pada Toolbar 
 

Tabel 3. Perintah Meratakan Data pada Toolbar 
 

Toolbar  Perintah 

Align Left 

Center 
 

Align Right 
 

Merge and Center 

Keterangan 

Data ditampilkan rata kiri 

Data ditampilkan rata tengah 
 

Data ditampilkan rata kanan 
 

Menyambung beberapa kolom, dan menaruh 

data ditengah kolom baru tersebut



 

N. Menambahkan Garis Pembatas dan Bingkai 
 
1. Sorotlah sel atau buatlah range, tempat yang akan diberi bingkai 

2. Pilih dan klik menu Format(O), Cells (CTRL+1). Lalu klik tab border. Kotak dialog akan tampil 
seperti di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 14. Kotak Dialog Format Cells – Tab Border 
 
3. Pada bagian Presets, pilih dan klik salah satu tombol berikut : 

• None, digunakan untuk menghapus garis pembatas dan bingkai 

• Outline, digunakan untuk membuat bingkai disekeliling sel atau range 

• Inside, digunakan untuk membuat garis pembatas didalam range 

4. Pada bagian Border, pilih dan klik garis pembatas yang diinginkan 

5. Pada kotak pilihan Style, pilih jenis garis yang diinginkan 

6. Pada kotak pilihan Color, pilihlah jenis warna yang diinginkan 

7. Gambar di bagian border adalah preview bingkai atau garis pembatas yang telah anda set. Klik OK 

bila sudah selesai. 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 15. Contoh Bentuk Garis Pembatas dan Bingkai



 

O. Menyisipkan Sel, Baris dan Kolom 
 

Kadangkala kita perlu untuk menyisipkan baris atau kolom karena saat memasukkan/mengetikkan 

data, ternyata ada data2 yang terlewat. Langkah2 yang dapat ditempuh adalah seperti berikut ini : 

1. Sorotlah sel, atau buatlah range tempat sel, baris atau kolom baru akan disisipkan 

2. Pilih dan klik di baris menu : 

Insert, Rows untuk menyisipkan baris baru 

Insert, Column untuk menyisipkan kolom baru 

Insert, Cells untuk menyisipkan sel baru 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 15. Contoh Penyisipan 2 Buah Baris Pada Lembar Kerja 
 
 

P. Menghapus Sel, Baris atau Kolom 
 

Selain data yang terlewat, terkadang kita juga menemukan data2 yang mengalami penulisan dua 

kali. Untuk yang semacam ini, untuk memperbaiki penulisan data dapat ditempuh dengan menghapus sel, 

baris ataupun kolom. 

1. Sorot sel atau range tempat sel, baris atau kolom yang akan dihapus 

2. Pilih dan klik menu Edit, Delete. Kotak dialog Delete akan ditampilkan 

3. Pilih dan klik salah satu pilihan berikut ini : 

• Shift cells left, digunakan untuk menghapus isi sel atau range yang anda sorot dan menggantinya 

dengan data pada baris sama di sebelah kanannya. 

• Shift cells up, digunakan untuk menghapus isi sel atau range yang anda sorot dan menggantinya 

dengan data pada kolom sama di sebelah bawahnya 

• Entire row, digunakan untuk menghapus seluruh baris pada sel atau range yang anda sorot 

• Entire column, digunakan untuk menghapus seluruh kolom pada sel atau range yang anda sorot 

4. Klik OK



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 16. Contoh Penyisipan 2 Buah Baris Pada Lembar Kerja 
 
 
 

SOAL LATIHAN 
 

Buatlah lembar kerja daftar upah harian dari PT. SUKA MAKMUR seperti ditampilkan dibawah ini. 

Masukkan pula isi dari WAKTU KERJA dan TOTAL UPAH yang masih kosong, serta kemudian 

ubahlah bentuknya menjadi bentuk table. 
 
Ketentuan Soal : 

• Waktu Kerja = Jam Keluar Jam Masuk 

• Total Upah = Waktu Kerja * 24 * Tarif Upah/Jam



 

MODUL 4: 

MICROSOFT POWERPOINT 2007 
 
 

Mengenal Power Point 2007 
 

Micorosoft PowerPoint 2007 adalah program aplikasi untuk membuat presentasi 

secara elektronik yang handal. Presentasi Power Point dapat terdiri dari teks, grafik, objek 

gambar, clipart, movie, suara dan objek yang dibuat program lain. 

Program ini pun dapat dicetak secara langsung menggunakan kertas, atau dengan 

menggunakan transparansi untuk kebutuhan presentasi melalui Overhead, serta dapat 

dicetak untuk ukuran slide film. Apabila dibutuhkan dibagikan kepada audiens sebagai 

bahan pendukung dalam presentasi, maka kita dapat mencetaknya seperti notes, handout 

dan outline. Kita juga dapat menampilkan presentasi secara online baik melalui internet 

maupun intranet. 

Tampilan Ms. PowerPoint 2007 mengalami perubahan yang cukup signifikan 

dibandingkan versi sebelumnya. Pada dasarnya semua tools yang ada pada Ms. 

PowerPoint 2007 juga ada versi yang belumnya, tetapi tampilannya sangat berbeda dan 

terdapat beberapa fitur tambahan. Jika Anda telah menguasai Ms. PowerPoint sebelumnya, 

maka Anda akan lebih mudah untuk mempelajari kembali penggunannya pada Ms. 

PowerPoint 2007. 

Mengaktifkan Ms. PowerPoint 
 

Langkah pertama yang harus dilakukan adalah mengaktifkan Ms. Power Point 2007 

yang ada di komputer Anda.. Pengaktifan Ms. Power Point 2007 ini bisa dilakukan 

dengan langkah berikut : 

• Klik START, pilih Program, pilih Microsoft Office, dan kemudian klik Power Point.



 

Posisi menu bisa saja tidak sama antara satu komputer dengan komputer lainnya, 
 

Jika Anda sudah membuat shortcut dan menempatkannya pada desktop, maka Anda dapat 

mengaktifkan Ms. PowerPoint 2007 dengan mengklik (double click) icon shortcut tersebut. 

 
 

Lembar Kerja Ms. PowerPoint 
 

Seperti telah disampaikan di atas, tampilan lembar kerja Ms. PowerPoint 2007 berbeda 

dengan Ms. PowerPoint sebelumnya (mis: Ms. PowerPoint 2003), begitu juga dengan 

penggunaan istilahnya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2. Lembar Kerja Ms. PowerPoint 2007 
 
 
 
 
 
 
 
 
 
 
 

Gambar 3.Tool in Ms. PowerPoint 
 
 
 
 

Fungsi dari Tools dalam Ms. PowerPoint 2007 
 

Terdapat perbedaan istilah yang digunakan Ms. PowerPoint 2007 dibandingkan versi 

sebelumnya, antara lain penggunaan istilah Ribbon Tabs untuk menggantikan menubar dan 

Ribbon untuk kumpulan toolbar (tools group).



 

a. Fungsi Utama Tombol Ms. Office (Ms. Office Button) 
 

Ms. Office Button berisi fungsi-fungsi utama dari File, antara lain : New, Open, Save, 

Save as, Print, Prepare, Send & Publish. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.Fungsi Ms. Office Button 
 
 
b. Quick Access Toolbar berisi shortcut untuk fungsi Save, Undo, and Repeat. 
 

Shortcut ini dapat ditambah dengan mengklik panah di sebelah kanan. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 5.Quick Access Toolbar 
 
 

Jika kita mengaktifkan seluruh menu yang ada di pilihan Customize Quick Access 
 

Toolbar, maka shortcutnya akan aktif pada Quick Access Toolbar, seperti gambar berikut ini 
 

:



 
 
 
 
 
 
 

Gambar 6 Customize Quick Access Toolbar 
 
 
c. Ribbon Tabs 
 

Setiap Ribbon Tab akan menampilkan Ribbon yang berisi beberapa set dari Tool 

Groups. Ribbon tabs dalam Ms. PowerPoint 2007 antara lain : Home, Insert, Design, 

Animations, Slide Show, Review, dan View. 

 
 
 
 

Gambar 7 Ribbon Tabs 
 
 
a. Ribbon Tab Home 
 

Pada Ribbon Tab Home terdapat beberapa tool group, antara lain : Clipboard, 

Slides, Font, Paragraph, Drawing dan Editing, yang berfungsi untuk mengatur format slide 

dan isinya. 

Clipboard, terdapat tombol copy, paste, cut, dan format painter. 

Slide, terdapat tombol add slide, layout, reset dan delete. 

Paragraph, terdapat tombol untuk mengatur perataan (alignment), bullet and numbering, 

line spacing, dan beberapa tombol untuk mengatur paragraph. 

 Drawing, terdapat tombol Text Box, Austoshape, Arrange, Quick Styles, Shape Fill, 

Shape Outline, dan Shape Effects. 

Editing, terdiri dari tombol Find, Replace, dan Select. 
 
 
b. Ribbon Tab Insert 
 

Ribbon tab Insert terdiri dari beberapa tool group, antara lain : 

Tables, perintah untuk menambahkan table pada tampilan slide Anda. 

 Illustrations, terdapat tombol-tombol yang bisa Anda gunakan untuk menyisipkan 

gambar, clipart, photo album, shapes, smartart, dan chart (grafik). 

Links, tombol-tombol pada tool group ini dapat digunakan untuk membuat link pada slide. 

Media Clips, untuk memperkaya tampilan slide Anda, maka anda dapat menambahkan 

file sound (suara) atau movie (film).



 

c. Ribbon Tab Design 
 

Jika anda mengklik Ribbon tab Design, maka akan muncul Ribbon denganbeberapa 

tool group, antara lain : Page Setup, Themes, dan Background, berfungsi untuk mendesain 

slide Anda. 

 Page Setup, terdapat tombol untuk mengatur orientasi dari slide, apakah anda akan 

menggunakan orientasi portrait atau landscape. 

 Themes, Anda bisa menggunakan pilihan desain yang sudah disiapkan oleh Ms. 

PowerPoint 2007untuk slide Anda. 

Background, untuk memperindah slide yang Anda buat, anda bisa menata latar belakang 

slide Anda dengan menggunakan menu pada toolgroup ini. 

 
 

d. Ribbon Tab Animations 
 

Pada Ribbon Tab Animations, Anda bisa menambahkan berbagai macam bentuk 

animasi pada slide Anda. Terdapat 3 tool group yang bisa Anda gunakan, antara lain : 

Preview, tombol ini dipergunakan untuk melihat hasil dari animasi yang Anda berikan 

untuk slide Anda. 
 

 Animations, Anda dapat memilih animasi bagi objek yang ada pada slide, terdiri dari 

animate dan custom animations. 

Transition to This Slide, untuk memebrikan slide pada perpindahan slide yang Anda 

buat. 

 
 

e. Ribbon Tab Slide Show 
 

Ribbon Tab Slide Show terdiri dari beberapa tool group, antara lain : 
 

Start Slide Show, untuk menentukan dari mana slide Anda dijalankan, apakah dari awal 

(from beginning) atau dari slide yang sedang aktif (from current slide show) atau pilihan 

Anda sendiri (custom slide show). 

Set Up, pada tool group ini terdapat tombol yang bisa digunakan untuk menyembunyikan 

slide (hide slide), merekam narasi (record narration) dan menentukan urutan slide 

(rehearse timings) yang akan ditampilkan. 

Monitors, Anda bisa mengatur resolusi dari slide presentasi Anda pada tool group ini. 
 
 
f. Ribbon Tab Review 
 

Terdapat tiga tool group pada Ribbon Tab ini, antara lain : 
 

 Proofing, digunakan untuk melakukan pengecekan pada tata tulis yang Anda buat di 

slide. 

Comments, Anda bisa memberikan catatan pada slide yang Anda buat. 
 

Protect, Anda bisa menggunakannya untuk melindungi slide presentasi yang Anda buat.



 
 
 

g. Ribbon Tab View 
 

Tool group yang terdapat pada Ribbon Tab ini antara lain : 
 

Presentation Views, pada bagian ini Anda dapat melihat keseluruhan dari slide yang 

telah Anda buat. Anda bisa melihatnya secara normal, slide sorter, notes page, dan slide 

show. Selain itu Anda juga dapat membuat slide Master sesuai dengan desain yang Anda 

inginkan. 

 Show/Hide, untuk membantu Anda dalam membuat slide presntasi, Anda bisa 

menampilkan penggaris (ruler) dan garis bantu (gridlines). 

Zoom, Anda dapat memperbesar ukuran slide yang Anda buat atau secara normal. 

Color/Grayscale, Pada bagian ini anda dapat menentukan apakah slide yang Anda buat 

berwarna (color) atau hitam putih (grayscale). 

Window, Anda manata tampilan window PowerPoint apakah secara cascade, split, atau 

berpindah ke window lain. 

 
 

4. Dialog Box Launcher 
 

Apabila Anda meng-klik Dialog Box Launcher berupa panah kecil di sudut sebalah 

kanan bawah tools Group, maka akan teruka Dialog Box yang mempunyai pilihan dan 

setting dari toolgroup tersebut. 

 
 

Menyimpan Dokumen Ms. PowerPoint 2007 
 

Ada beberapa hal yang perlu diperhatikan apabila Anda akan menyimpan dokumen 

yang Anda buat, antara lain : 

• Apabila Anda menyimpan dokumen sebagai Ms. PowerPoint 2007, maka dokumen 

tersebut tidak dapat dibuka pada Ms. PowerPoint versi sebelumnya. 

• Selalu menggunakan Save as untuk menyimpan dokumen, karena akan 

memudahkan memilih tipe penyimpanan, disesuaikan dengan Ms. PowerPoint yang 

digunakan dan kebutuhan lainnya. 

 
 

Langkah-langkah yang harus dilakukan dalam menyimpan dokumen, antara lain : 
 

Klik logo/tombol Ms. Office yang ada pada sudut kiri atas lembar kerja, kemudian pilih 

Save as. Ms. Office Button >> Save as 

a. PowerPoin Presentation, Anda dapat menyimpan dokumen yang anda buat sesuai 

dengan format Ms. PowerPoint 2007 (*.pptx) 

b. PowerPoint Show, Anda menyimpan dokumen yang Anda buat dimana jika Anda 

mengaktifkannya maka akan terbuka sebagai tampilan Slide Show.



 

c. PowerPoint 97-2003 Presentation, Menyimpan copy dari presentasi yang anda 
 

buat dengan format yang dapat dibuka di PowerPoint 97-2003. 
 

d. Find Add-Ins for other file format, Anda dapat menyimpan dokumen yang Anda 

buat dalam bentuk file formet yang lain, misalkan pdf dan xps. 

e. Other Formats, membuka dialog box Save as, untuk memilih dari semua tipe file 

format yang tersedia atau memungkinkan. 

 
 

FORMAT DOKUMEN 
 

Agar presentasi yang kita buat bener-benar sempurna dan layak untuk ditampilkan, 

Anda harus melakukan pengeditan dan pemformatan. Dalam pembuatan presentasi Anda 

akan bekerja dengan teks, table, slide dan elemen-elemen presentasi lain. 

 

Bekerja dengan Teks 
 

Teks merupakan elemen presentasi yang paling penting. Agar presentasi kita 

menarik dan membantu Anda dalam menjelaskan sesuatu, maka teks yang singkat, padat, 

jelas dan menarik sangat berperan penting. 

Menambahkan Teks 
 
Dalam Power Point, terdapat empat tipe teks yang dapat kita tambahkan dalam presentasi 

yang kita buat, antara lain : 

 

1. Teks Placeholder 
 

Placeholder adalah kotak yang dibatasi titik-titik yang menjadi sebagian besar layout 
 

slide. Kotak ini menjadi tempat judul dan teks atau objek seperti grafik, table dan gambar. 

Layout Slide terdiri dari placeholder teks dan objek dalam suatu variasi kombinasi. Dalam 

placeholder teks, ketik judul, sub judul, dan teks pada slide Anda. Anda dapat mengatur 

ukuran dan menggerakan placeholder dan memformatnya dengar border dan warna. 

 
 
 
 
 
 
 

Gambar 2.1. placeholder 
 

Untuk menambahkan teks ke placeholder, klik bagian dalam place holder, dan 
 

kemudian ketik atau paste teks yang hendak anda tuliskan.



 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2.2. Membuat teks pada placeholder 
 
 
 
2. Teks Autoshape 
 

Autoshape adalah satu grup bentuk-bentuk siap pakai yang termasuk bentuk dasar, 

seperti segi empat, lingkaran, ditambah dengan variasi-variasi garis dan hubungan, panah, 

symbol flowchart, bintang, spanduk dan callout. Autoshapes seperti garis dan panah muncul 

pada slide dalam bentuk utuh namun anda dapat menggerakan, merotasi dan mengubah 

ukurannya. Jika Anda ketik teks ke dalam sebuah Autoshape, teks tersebut akan menjadi 

satu dengan Autoshape dan bergerak atau berotasi bersamanya. 

 
 
 
 
 
 
 
 
 

Gambar 2.3. Shapes 
 

Anda dapat memilih salah satu bentuk Autoshape sesuai dengan yang anda 
 

perlukan, kemudian jika anda memerlukan teks pada autoshape tersebut Anda bisa 

melakukannya dengan meng-klik kanan bentuk Autoshape tersebut dan memilih add text, 

lalu ketikan teks yang Anda inginkan. 

 
 
 
 
 
 
 
 
 
 

Gambar 2.4. Membuat teks pada autoshape



 

3. Tex Box 
 

Text Box adalah suatu tempat untuk teks yang dapat bergerak dan berubah ukuran. 

Anda dapat menggunakan text box untuk menempatkan teks dimanapun pada slide, seperti 

di luar sebuah placeholder teks. Contoh. Anda dapat menambahkan judul atau keterangan 

untuk sebuah gambar, atau table, atau grafik dengan membuat sebuah text box dan 

menempatkannya di dekat objek tersebut. Selain itu, text box dapat digunakan untuk 

menambahkan suatu teks ke suatu Autoshape, tetapi Anda tidak ingin teks tersebut menjadi 

satu bagian dengan Autoshape. Suatu text box dapat memiliki border, pengisi,bayangan, 

atau efek tiga dimensi, dan Anda dapat merubah bentuknya. 

 
 
 
 
 
 
 

Gambar 2.5. Tex Box 
 
4. WordArt 
 

WordArt adalah objek yang Anda buat dengan efek siap pakai dan dapat diformat. 

Anda dapat menggunakan WordArt untuk teks yang menarik. WordArt dapat diperbesar, 

diperkecil, dan dirotasi atau dijadikan tiga dimensi atau vertikal. 

 
 
 

Teks yang Anda ketik di placeholder, seperti judul dan daftar ber bullet, dapat diedit 

di slide atau tab outline. Teks dalam sebuah objek, seperti text box atau Autoshape, dan 

Teks WordArt tidak muncul pada outline dan harus di edit di slide. 

Latihan 1 
 

Buat beberapa slide di berikut ini 

.Slide 1 

 
 
 
 
 
 
 
 
 
Slide 2



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slide 3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slide 4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MENGATUR FORMAT TEKS 
 
Format Font 
 

Anda dapat menformat font dengan mempergunakan tool group font yang terdapat 
 

pada tab ribbon Home. Tool group font akan aktif jika anda mengaktifkan teks yang terdapat 
 

pada place holder atau text box. Untuk mengaktifkan pemilihan pada toolgroup font, Anda 

harus menyeleksi terlebih dahulu teks yang akan di format, atau meng-klik placeholder teks 

yang akan di format.



 

1. Menyeleksi teks (mem-blok teks yang akan di format) 
 
 
 
 
 
 
 

Gambar 2.7. Menyeleksi teks 
 

2. Klik placeholder (meng-klik garis pada placeholder) 
 
 
 
 
 
 

Gambar 2.8. mengaktifkan placeholder 

(garis menjadi tidak putus-putus) 

Setelah Anda melakukan salah satu langkah di atas, Anda dapat melakukan format 

melalui toolgroup font yang terdapat di Ribbon Tab Home. 

 
 
 
 
 
 
 
 

Gambar 2.9. Toolgroup Font 
 

Selain melalui toolgroup font, Anda juga dapat melakukan format font dari font dialog 

box yang dapat diaktifkan dengan meng-klik : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2.10. Font Dialog Box 
 
Toolgroup Font terdiri dari : 
 

1. Font (Jenis Huruf)



 

Anda dapat mengganti jenis huruf yang dipergunakan untuk teks yang Anda buat, 

pilihan bentuk huruf dapat Anda pilih melalui toolgroup font atau melalui Font Dialog 

Box. 

2. Font Size (Ukuran Huruf) 
 

Dalam membuat tampilan presentasi ukuran huruf sangatlah penting, besar kecilnya 

3. Font Style (Bold, Italic, Underline) 

4. Effect 
 

Anda dapat memberikan efek pada teks yang Anda buat, pilihannya bisa Anda 

lakukan melalui tombol yang ada di toolgroup font atau melalui Font Dialog Box. 

5. Character Spacing 
 

6. Increase/Decrease Font Size 
 

Tombol inu berfungsi untuk mengatur ukuran huruf sesuai dengan keinginan Anda. 

7. Clear All Formating 

Tombol ini berfungsi untuk menghapus semua perintah format yang Anda lakukan 

dan hanya meninggalkan teks aslinya. 

8. Change Case 
 

Change Case berfungsi untuk merupakan penggunaan huruf besar dan huruf kecil 

pada teks yang Anda buat. 

9. Font Color 
 

Selain melakukan perubahan pada jenis, ukuran, gaya dsb. Seperti disampaikan di 

atas, Anda juga dapat memberikan warna pada teks yang Anda buat 

Latihan: 
 

Ubahlah slide yang telah anda buat sehingga menjadi: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Format Paragraph 
 

Selain melakukan format Font, Anda juga dapat melaklukan format Paragraph 
 

dengan mempergunakan toolgroup Paragraph yang terdapat pada ribbon tab Home. Untuk



 

mengaktifkan hasil format yang anda lakukan, terlebih dahulu anda harus melakukan salah 

satu langkah di bawah ini 

 Meng-klik placeholder yang berisi paragraph yang hendak di format, langkah ini 

dilakukan jika hasil format berlaku untuk keseluruhan paragraph yang ada pada 

placeholder. 

 Menyimpan kursor pada salah satu paragraph, proses format yang anda lakukan 

hanya akan aktif pada paragraph di mana kursor berada. 

 Menyeleksi paragraph yang hendak di format, ini dapat dilakukan untuk memilih 

paragraph tertentu yang akan di format. 

 
 
 
 
 
 
 

Gambar 2.20. Toolgroup Paragraph 
 
 

1. Alignment/Perataan 
 

Selain perataan secara horizontal yang dilakukan dengan mengklik tombol 
 

, Anda juga dapat melakukan perataan secara vertikal dengan 
 

mengklik tombol 
 

2. Bullet and Numbering 
 

Pada     slide     theme     maupun     layout     terdapat     pilihan     yang     mengandung 

bullet/numbering, pilihan bullet/numbering yang sudah anda bisa Anda ganti dengan 

 

mengklik tombol , lalu memilih bentuk bullet/numbering yang Anda 
 

kehendaki. 
 

3. Line Spacing 
 

Tombol ini dipergunakan untuk mengatur spasi pada paragraph yang Anda buat, 

selain pilihan di atas Anda juga dapat mengatur spasi sesuai dengan keperluan Anda 

dengan mengklik Line Spacing Options. 

4. Column



 

Latihan: 
 

Ubahlah slide yang telah anda buat sehingga menjadi:



 

Menyisipkan Gambar/Clip Art 
 

1. Menyisipkan Gambar 
 

Untukmenyisipkan gambar pada slide yang Anda buat, Anda dapat melakukannya 

dengan mengklik tombol Picture pada toolgroup Illustration. 

 
 
 
 
 
 

Gambar 2.27. Toolgroup Illustration 
 

Setelah Anda mengklik tombol Picture, maka akan muncul Dialog Box Insert Picture, 

selanjutnya Anda tinggal memilih file gambar yang Anda kehendaki. 

 
 

2. Menyisipkan Clip Art 
 

Selain gambar, Anda juga dapat menyisipkan Clip Art pada slide presentasi yang 

Anda buat, Clip Arti disediakan oleh Ms. Office maupun koleksi Anda dan juga hasil 

penelusuran web site. 

Setelah meng-klik tombol Clip Art, maka akan mucul Task Pane Clip Art, untuk 

mempermudah pemilihan maka sebaiknya Anda hanya mengaktifkan penelusuran 

untuk My Collection dan Office Collection saja. 

Pilihlah Clip Art yang Anda kehendaki, Anda bisa mengklik langsung Clip Art yang 

Anda pilih, atau mengklik panah kecil yang mucul disbelah kanan saat Anda 

menyorot kursor pada clip art yang Anda kehendaki. 

 
 

Latihan: Buatlah slide berikut ini:



 

HYPERLINK 
 
 

Hyperlink merupakan fasilitas dalam pembuatan tampilan presentasi untuk 
 

mempermudah Anda mengatur slide yang Anda buat. Fasilitas yang ada pada Ribbon Tab 

Insert ini mempermudah kita untuk menampilkan bagian tertentu dari slide yang kita buat, 

disesuaikan dengan kebutuhan Anda dalam presentasi. 

 
 

MEMBUAT HYPERLINK PADA SLIDE PRESENTASI 
 

1. Sebelum Anda membuat Hyperlink, maka buatlah slide presentasi seperti di bawah 

ini



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Buatlah slide presentasi di atas semenarik mungkin, dengan desain yang Anda buat sendiri. 

Anda bisa mendesainnya seperti Anda mendesain sebuah Web Site. 

 
 

2. Membuat Link 
 

a. Seleksilah teks, gambar, clip art atau place holder yang akan Anda Link. 
 

b. Kemudian, Klik Ribbon Tab Insert, lalu pilih Hyperlink 

c. Maka, akan mucul jendela dialog seperti berikut : 

 Existing File or Web Page : Anda me-link pada file yang telah ada sebelumnya, yang 

Anda simpan pada folder tertentu. Atau Anda melakukan link ke alamat web tertentu 

dengan menuliskan alamat web tersebut pada Address Bar. 

 Current Folder : Link pada file yang ada pada folder dimana file kita ada. 

 Browsed Page : Memilih link pada drive/folder dimana folder kita berada 

 Recent File : Muncul file-file yang bisa kita pilih untuk di link 

 Place in This Document : Anda melakukan link pada slide presentasi yang sama 

yang sudah Anda buat sebelumnya. 

 Create New Document : Membuat document baru yang akan kita link dengan slide 

presentasi yang kita tentukan. 

 E-mail Address : Link pada alamat email tertentu. 
 
 
d. Untuk pilihan link berdasarkan slide yang kita pilih, maka kita melakukan link 

pada slide lain yang ada pada file presentasi kita (Place in This Document). 

 
 

Teks yang sudah ter-link akan berwarna biru dan bergaris bawah.



 

e. Melakukan Link pada file lain yang ada di folder (misalkan link ke format 

document) 

f. Mencoba aktif tidaknya link yang kita buat. 
 

Untuk melihat aktif tidaknya link yang kita buat, maka kita harus menjalankan slide 

presentasi yang telah kita buat tersebut. Caranya : 

 Mengaktifkan ribbon tab slide show dan memilih salah satu pilihan pada ribbon start 

slide show. Atau, 

 Mengklik tombol yang ada di bagian bawah, untuk menampilkan halaman yang 

sedang aktif. 

g. Untuk setiap halaman yang menjadi link bagi menu utama dari slide Anda, 

Anda harus membuat link kembali ke menu utama, atau menu tertentu sesuai 

dengan yang Anda inginkan 

 
 

MENJALANKAN PRESENTASI 
 

Saat menjalankan presentasi pada layar komputer (on-screen), seluruh layar akan 

digunakan dan komponen-komponen layar seperti toolbar, menu, dan lain-lain akan hilang 

dari layar. Cara menjalankan presentasi ini cukup sederhana, buka presentasi yang akan 

dijalankan, lalu klik menu View, Slide Show atau menu Slide Show, View Show. 


